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■ Legal notice & Contact

The license included with this product is a single user license for an installation on a single 
computer. Please contact our support team if you need additional licenses. 
This product is copy protected. Please note that Tone2 will deactivate licenses of users who share our 
software without permission. Violators will be excluded from customer resources, services and 
updates. Under the DMCA, copying and sharing copyrighted materials without a license is illegal, 
violations to copyright law may carry heavy civil and criminal penalties.

If you have any difficulties installing or using Icarus, please contact us by visiting our website.

Tone2 website https://www.tone2.com

Product installation https://www.tone2.com/product-installation.html

Soundsets https://www.tone2.com/overview_ic.html

Video tutorials https://www.tone2.com/video-tutorials.html
    
Tone2 forum https://www.tone2.org/forum/index.php
    
Support mailto:support@tone2.com

           https://www.youtube.com/user/Tone2Audiosoftware

  https://www.facebook.com/Tone2Audiosoftware

 https://twitter.com/Tone2Audio

  

Credits

Development:  Markus Krause
Programming & Graphics:  Markus Krause
Thanks go to:  Family and friends, all sound-designers & beta testers and of course 
all Tone2 customers for their continued support.
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■ Installation & Authorization procedure

Together with the download link from Share-it you have received attached to the product delivery 
email a keyfile named 'Icarus3.t2k'. 
This file contains your personal serial number & name and is used to unlock the full version.

Installation PC & Mac

1. Close your host (Logic, Live, Cubase, etc.)

2. Install the full version of the plugin.

3. Open your host program

4. Do a plugin re scan in the host if it does not list Icarus 3 by default. Detailed instructions on 
how to perform a rescan can be found in your host's manual

5. Open Icarus 3

6. Click on the “Click here to activate it” part of the screen.

       Click on the “Click here to activate it”, browse-to & select your Icarus3.t2k keyfile

7. Browse-to & select your keyfile 'Icarus3.t2k' to activate the full version

8. Restart the plugin. Note that some host programs may require a complete restart.
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■ Welcome to Icarus 3

Icarus is a wavetable synthesizer, equipped with a high-end quality sound engine. An engine that is 
flexible as well as offer an enormous number of features, yet remains easy and intuitive to work with.
We call Icarus a '3D wavetable synthesizer', because we expanded the wavetable concept, allowing 
you to cross-blend waveforms, with an additional dimension for morphing.
Next to its wavetable capabilities it also offers resynthesis, true stereo architecture, hypersaw 
oscillators, a wavetable editor, modular effects, a vocoder, dual filter section, programmable 
arpeggiator and a comfortable patch browser.  Which is why Icarus is one of the most powerful 
synthesizers on the market. 

■ Resynthesis

Working with conventional resynthesis methods you need a deep knowledge of sample editing to 
achieve good results, doing consuming pre-processing with a sample editor as well as require precisely
tuned samples.
We have taken care of these problems and developed completely new algorithms. Icarus'  resynthesis 
works on nearly any kind of audio material, is very easy to use and provides you with high quality 
results.  Simply click on the button - select a wav file - wait for some seconds and Icarus will 
automatically create a patch, which sounds very similar to the original sound. Optionally you can use 
the morph modes or the wavetable editor to further shape your sound.
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■ Effects

Tone2 Icarus comes with a flexible effects section. Three Modular slots, each with 60 different effect 
types. You can create your own custom effects, which can be saved & loaded separately. The flexible 
routing allows you to route single oscillators to different effects. 
The innovative ducking mode can change the dry/wet mix of delays and reverbs dynamically, resulting 
in a more transparent mix. The additional feedback section allows you to route the output back to the 
input, this way you can create completely new effects, like a delayed-phaser or a feedbacked vibrato. 
An additional EQ and a limiter is provided to make your sound sit right in the mix. We developed 
innovative microtuning algorithms, which make chords sound more fat, harmonic and warm.

■ Oscillators

Icarus is a '3D wavetable synthesizer', we expanded the wavetable concept, allowing you to cross-
blend waveforms, with an additional dimension for morphing. You can use any of the 64 different 
'morphmodes' to further shape the sound of your wavetables: Waveshaping, time-stretching, pitch- 
shifting, granulizing, stacking, PWM, formant shifting, BPM syncing, phase distortion, reversing, 
ringmodulation, sync, rearranging, FM, spectral editing, looping, denoising, mixing,... - literally 
anything is possible.
Icarus offers three oscillator blocks with stereo architecture. Each oscillator block itself again can 
contain up to 10 detuned hypersaw oscillators. 

We've expanded the popular hypersaw concept with a stereo architecture, precise phase control, 
punch and the ability to make single oscillators play chords. 
38 different modes are available, including, hypersaw, supersaw, stereo hypersaw, unison, stacking, 
chords and flanging.
The hypersaw modes can be combined with any kind of wavetable and morph mode. 

■ Filters

Tone2 Icarus comes with a powerful, modular filter section. Two blocks, each equipped with true 
stereo architecture and a multi-mode filter. 

62 different sounding filter types are available: Vocal, fractal, analog, digital, resonator, EQ, ring 
modulation, amplitude modulation, FM, phaser, comb, physical modeling, multi-mode, resampling, … 
All filters offer the highest possible sound quality, many of them exclusive to Icarus.
The animated display offers an immediate visual overview of the filter's frequency response, making it
easy to understand and tweak the filters.
Flexible routing allows you to route every oscillator individually to filter1, filter2 or bypass. 
Additionally, two distortion sections, each with 9 different modes allow you to further shape the 
sound.
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■ Vocoder

Icarus contains a high-end quality vocoder module with 1024 bands. It's very easy to use: Simply click 
on 'Vocoder' and select a wav file containing speech, Icarus will analyze this file and automatically 
create a patch. 
Optionally, apply one of the morph modes to further shape your sound. Playing the sound forwards, 
backwards, formant shifting, time-stretching and looping is also possible.
The vocoder sound is automatically stored within your patches and songs, you won't have to worry 
about managing these additional files on your hard disc.

■ Arpeggiator

Almost a synth by itself, the arpeggiator section holds the key to all of your arpeggio needs. It provides
you with the tools to set up & use your own arpeggios, in a way that is both powerful and easy. 
Working with the arpeggiator is very simple, just lay down your notes inside the note sequencer and 
select the play direction. The arpeggiator also supports advanced features such as chords, glides, 
swing & shuffle, split, matrix integration, as well as giving you very precise control over note-sorting, 
play direction and velocity.
Don’t feel like programming your own patterns? Use one of the built-in patterns or load one of the 
many external pattern presets to use as a starting point.
Working with an arpeggiator should be fun and inspiring, the arpeggiator in Icarus is as fun and 
inspiring as it is powerful, flexible and easy to use.

■ Sounds

With a powerful and sonically versatile approach to audio production, Icarus provides you with truly 
outstanding new sounds. 
Icarus comes with an astounding sound collection of production-ready sounds designed by 
professional sound designers. A comfortable patch browser is provided to give you an instant overview
of the available categories and sounds, together with an on-screen keyboard to audition them from 
within the patch browser. Picking the sound you want is as easy as it can be. Icarus is ready for any 
type of music you play! 

■ Interface

The user-friendly interface makes tweaking accessible to everyone, regardless of skill level or 
experience. All controls provide you with visual feedback, making it easy to understand and tweak the 
synthesizer. The animated displays and tool tips instantly visualize what the filters, the LFOs, the 
envelopes and the oscillators are doing.
With different color schemes available for the interface and with several instances of the synthesizer 
loaded at the same time, it's even possible to show single instances with different colors. Helping you 
to keep an overview when working on a complex project with many instances of Icarus.
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■ Wavetable editor

You can use the built-in wavetable editor to create your own wavetables or to edit one of the many 
stock wavetables that ship with Icarus.
Using only a mouse-click, a smart wavetable generator allows you to generate an infinite number of 
completely new and musically useful wavetables. Or even use the mouse to paint your own 
waveforms. 
The spectral editor turns Icarus into an additive synthesizer, giving you detailed control over the 
partials and phase. It is possible to drag & drop waveforms or wavetables into the editor or oscillators. 
The wavetables are stored within your patches and songs, so you don't have to worry about managing 
any additional files on your hard disc. 
Many common wavetable & waveform formats are supported and it is possible to import and export 
wavetables from-and-to other synthesizers.
A large, professional set of tools are available, giving you a comfortable and efficient way to edit 
waveforms and wavetables. This includes basic features like, cutting, mixing and filtering, as well as 
advanced tools like, denoising, enhancing, resynthesis, vocoder, spectral modification and phase 
manipulation.
Icarus' flexible, compact and open file format allows sound designers & artists to easily create their 
own soundsets, waveforms and wavetables.

■ Modulation

Modulation is where the true power of a synthesizer emerges. By using the modulation matrix, Icarus 
allows you to connect dozens of modulation sources to all-important sound parameters. 
Want to use an LFO to wobble your filter? Simply set the proper assignments inside of the modulation 
matrix and you're on your way.
Modulate almost any parameter well up into the audio-rate speed, from internal modulation sources 
like the LFOs, to a wide variety of MIDI messages. We've also included midi-learn, so assigning CC's is 
as simple as a right-click and a knob-turn.

Modulation can be as simple or complex as you want it to be. Icarus’ modulation system is there to 
provide whichever modulation routing you require to create your perfect sound.

■ CPU 

CPU load is always an important factor to consider, especially in light of today's complicated multi-
track projects. We made sure that Icarus is as easy on your CPU as possible. Icarus offers a rich, deep 
sound, the very best sound quality, AND low CPU usage. What is the advantage of good sound quality 
if it consistently brings your system to a halt with a mere single instance of the synth?
The low CPU requirement ensures that you can easily use multiple instances of the synth without 
overloading your project and without the need to render tracks right in the middle of a creative 
session.
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■ User Interface

The Icarus user interface is designed to make patch designing and editing intuitive and fun. All the 
sound editing parameters are kept on a single page so that you can see the signal flow without getting 
lost in multiple tabs and pages. 

The UI (User Interface) is larger than most software synthesizers and resize-able to your preferred size.
Once your patch is built you can switch off the editor view leaving just the basic controls to save 
screen real-estate, simply click the Size button inside Icarus’ Main section and select one of the ‘Hide 
Editor’ options from its menu. 
Animated displays give you visual feedback so you can instantly see and hear the results of your 
actions.
Context sensitive tool-tips explain the function of the control that you're currently tweaking. The user-
friendly and accessible interface makes tweaking easy for anyone, regardless of skill level or 
experience.
The customisable interface allows you to select your favorite color scheme. Having several instances of
Icarus loaded at the same time, it's even possible to display single instances each with different colors.
This helps you with keeping the orientation, when you're working on a complex project containing 
many tracks.
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■ Main controls

The main section features the general performance options, like pitchwheel, velocity, playmodes and 
glide settings.

■ Patch Browser
On top of the main section you’ll find the Patch Browser, which offers a browser from which you can 
navigate patches and their categories as well as test play them using the added keyboard. More on the
Patch Browser can be found in the patch browser chapter.

■ Help menu

The Help menu offers links to the synth’s manual as well as the online tutorials. The synth’s credits are 
also found here. 

The Show version info will display which Icarus version is installed.
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■ Play mode selector
Play mode sets the number of voices (and how they are handled) available to the current patch and 
how Icarus reacts to you playing your keyboard controller. It can be set to Monophonic, legato and 
several Polyphonic modes. Having lower settings will use less CPU, more will increase CPU load but 
may be needed for certain patches to sound well (no voices being cut off or unnatural sustains)

◦ Monophonic – This mode sets the polyphony to 1 note 
(monophonic) which mimics the way the classic analogue 
synthesizers of the past behaved. 

◦ Legato new – The punchy sounding Legato new is suitable for 
modern music.
When you play a key, no gliding will occur – the oscillators will 
immediately play the new note. As soon as you release the second 
key the oscillators will glide. 
The glide knob controls the glide speed of the oscillators. If you set 
the Retrig (Re-trigger) option for the Envelopes to off, the 
Envelopes will also be re-triggered when you release a key.

◦ Legato Classic – This is a classic Legato. When you play the first key 
no gliding will occur. As soon as you press another key the 
oscillators will glide. 

The glide knob controls the glide speed of the oscillators. If you set the Retrig (Re-trigger) option for 
the Envelopes to off, the Envelopes will also be re-triggered when you release a key.

◦ Polyphonic 1-64 – These are Polyphonic play-modes similar to what you know from 
conventional synthesizers. 
The number represents the number of voices that are available. When this limit is reached 
the engine softly fades out voices without any clicks. If you use unison (2X or 4X), the 
number of voices is automatically multiplied by 2 or 4. This way voice management is taken
care of for you automatically. In most cases 6 or 8 voices will suffice. 

Should you notice that the CPU usage is too high you can reduce the number of voices or 
switch off any oscillator unison options. 
The glide knob controls the glide speed of the oscillators. In Polyphonic mode polyphonic 
gliding is supported. Gliding always occurs if the glide knob is set to a value larger than 0.
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■ Micro-tuning mode
Icarus probably comes with the most advanced micro-tuning section currently
available on the market. 
Micro-tuning is a subtle effect which enhances chords. It does not have an effect
on mono or legato sounds. When micro-tuning is active, certain notes are slightly
pitched up or down to achieve a more harmonic sounding chord. 
      
Piano tuners and organists did experiments for more than one hundred years to
find good settings, we have analyzed and enhanced their results further. 
With classic instruments like organs it is not possible to change the tuning of the
voices during playback, however this is possible in Icarus. The 'Dynamic' modes
analyze your chords in real-time and detune the voices in a subtle way. 
 
Is this difference audible?
  
The most easy way to hear the difference is to initialize a patch which uses a
single sawtooth. Select 'INIT > Init patch' from Icarus’ main section menu. The
default patch is already initialized with  'Dynamic Silky' as micro-tuning mode. 
Press two keys on the keyboard and play a minor third (3 halftones) and mayor
third (4 halftones) as chord. You will hear a beating with slow modulation. Now
press two keys on the keyboard and play an octave (12 halftones). Again you will
hear a beating with a very slow modulation. 
Now switch off the micro-tuning by selecting 'Standard tuning', which is used by
conventional synthesizers. Press two keys on the keyboard and play a minor third (3 halftones) and 
mayor third (4 halftones) as chord. You will hear a more disharmonic sound with a very fast beating. 
Now press two keys on the keyboard and play an octave (12 halftones) and you will hear a static and 
thin sound with no modulation at all.

The following Micro-tuning modes are available:

◦ Standard Tuning –  No micro-tuning is used. This mode is used by most conventional 
synthesizers. Use this mode for monophonic and legato sounds.

◦ Dynamic Thirds –  A subtle improvement of the standard tuning. Minor thirds (3 halftones)
and mayor thirds (4 halftones) are slightly enhanced.

◦ Dynamic Thirds+ – An improvement of the standard tuning. Minor thirds (3 halftones) and
mayor thirds (4 halftones) are moderately enhanced.

◦ Dynamic Just – Minor thirds (3 halftones), mayor thirds (4 halftones) and fifths (7 
halftones) are heavily processed. The frequency of the beating is minimized. This mode is 
extreme and can sound 'out of tune', but it can be useful for organs.
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◦ Dynamic Silky –  Minor thirds (3 halftones), mayor thirds (4 halftones) and octaves (12 
halftones) are moderately enhanced. This mode has a warm and silky sound with a slower 
beating and is a great choice for chords and sounds with slightly detuned oscillators. This 
innovative mode is exclusive and not available in other synthesizers.

◦ Dynamic Valotti – We extended the famous Valotti tuning with dynamic octave spreading. 
This mode has a very lively sound. The beating speed of chords varies. It is a good choice 
for sounds with moderately detuned oscillators and for analog emulation. This mode is 
exclusive and not available in other synthesizers. 

◦ Dynamic Subtle – Like 'Dynamic Silky' but with less extreme settings.

◦ Dynamic Octaves – Standard tuning with dynamic octave spreading. Thirds and Fifths are 
not affected. 

◦ Valotti – The classic Valotti tuning one of the most popular modes for classic music and 
organs. This mode has a lively sound. The beating speed of chords varies.

◦ Valotti Fat – We extended classic Valotti tuning with a subtle octave spreading. Maybe 
someone else already did this before. 

◦ Young – The Young tuning is quite popular.

◦ Werckmeister 3 – Many Organists prefer Werkmeister 3. It is popular for classic music.

◦ Young-Sorge, Kirnberger 3,Neidhardt & Hammer – These historical modes are well 
known. We think that Valotti and Werkmeister 3 sound better, but feel free to use them if 
you like them. There are a lot more microtuning modes and variations out there, but we 
think that quality is more important than quantity.

◦ Sinus 7cent, 5cent– These modes are not well known, but we think that they sound good 
and really deserve to get some attention. They sound similar to Valotti.

◦ Stretch Light – Standard tuning with subtle octave stretching. Some pianos are tuned this 
way.

◦ Stretch Medium – Standard tuning with octave stretching. Many pianos are tuned this 
way.

◦ Stretch Heavy – Standard tuning with heavy octave stretching. 

◦ Stretch Valotti – Valotti tuning with octave spreading. 
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■ Glide Mode
Glide Mode manages the glide mode options. The glide knob found inside the Main Section controls 
the glide speed of the oscillators. Gliding occurs if you set the glide knob to a value larger than 0. 
Inside the Glide Mode menu you can select from one of the several Glide modes that Icarus offers:
    

◦ Modern glide – A linear pitch sweep between notes. In most 
cases this will be the most musically useful sounding mode.

◦ Vintage glide – A logarithmic pitch sweep between notes which 
sounds more like 'analog' synthesizers. This mode lowpass filters 
the pitch of the oscillators. As a result you get faster gliding at the

                   beginning and slower gliding when the target pitch is reached.

◦ Variable glide – The speed of the glide depends on how far the distance between the two 
notes is. A glide over several octaves will take longer than gliding to a neighboring note.

        
■ Glide control        
The glide knob controls the glide speed of the oscillators. Gliding occurs if you set the glide knob to a 
value larger than 0. Inside the Glide Mode menu you can select from one of the several Glide modes 
that Icarus offers

■ Pitchwheel menu

◦ Off – Switches the Pitchwheel off. This is sometimes preferred if you assign modulation to 
the pitchwheel.

◦ Pitchwheel +-1 / +-48 – Switches the range of the Pitchwheel to a value of +-1 up to a 
range of +48.

  
 ■ Pan control
The pan control allows you to position the synth’s sound in the stereo field (left-middle-right) 

        
  

■ Volume control
 The Volume knob controls the master volume for Icarus.
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 ■ Vel control
The Vel (velocity) knob controls the amount of keyboard velocity applied to the volume.

 ■ FX Mix
The FX Mix knob controls the Dry / Wet setting for Icarus’ effects section.

 ■ Macro
The Macro control transmits MIDI Continuous Controller 1 messages (modulation wheel) when 
modified. Controlling this knob with your mouse does the same job as moving the modulation wheel 
on your keyboard controller. 
The Modwheel knob also acts as a visual indicator for your modulation wheel. By default, MIDI 
Continuous Controller 1 is used to change, or 'morph' between one timbre and another. 

■ Patch display
The patch display displays which patch is currently loaded. From here you can also easily navigate-to &
load new sounds, using any of the four arrow shaped buttons inside the Patch display window to 
navigate / switch to different patches or patch categories.

• Arrow Left (left of the Patch name) – loads the previous patch in the current patch category 

• Arrow Right (right of the Patch name) – loads the next patch in the current category 

• Arrow Left (left of the Category name) – loads the previous patch in the current patch category

• Arrow Right (right of the Category name) – loads the next patch in the current category
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■ Main section menu

■ File menu
The file menu offers several patch load & save options as well as Download, Optimize patch options 
and the Midi-learn reset.

◦ Load patch – Loads a patch from disk

◦ Save patch as – Opens a file dialog to save the current patch to 
file

◦ Quick save patch – The preset file inside the current category 
(within icarus_sounds) is overwritten.

◦ Download sounds – This takes you to Tone2's website where 
you can buy additional sound banks to be used with Icarus.

◦ Download update – This will take you to Tone2's download section from which you can 
download Icarus updates.

◦ Optimize patch – This removes unused wavetables and modulation matrix slots to enhance
performance and save hard disk space.

◦ Reset Midi-learn – Select this option to remove / reset all previously learned midi CC 
assignments. 

■ Init menu

◦ Init patch – This option initializes all of the synth's settings to 
their default values.

◦ Init Matrix – Initializes the Modulation Matrix settings to their 
default values.

◦ Init MSEG1 – Initializes MSEG1’s settings to its default values.

◦ Init MSEG2 – Initializes MSEG2’s settings to its default values.

◦ Init Filter 1 – Initializes Filter 1’s settings to its default values.
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◦ Init Filter 2 – Initializes Filter 2’s settings to its default values.
◦ Init Glitch-Sequencer – Initializes the Glitch-Sequencer’s settings to its default values.

◦ Init Drums – Initializes the Drum sequencer’s settings to its default values.

■ Reset
Resets the current patch.

■ Random
Random – This option randomizes all synth settings.

■ Shop
The Shop button will take you to Tone2's sound shop, where you can purchase new soundsets or 
expansions for Icarus.

■ Size menu
The size menu offers you 12 different GUI size options for switching Icarus' interface to your preferred 
setup / size.
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■ Main menu

The Main menu offers on / off buttons, as well as access to various sections within Icarus. Namely the 
Arpeggiator, Drum-sequencer, Glitch-sequencer, the Effects section, Modulation Matrix, Multi-Stage 
Envelope Generators and the Setup page. Also included are the Resynthesis & Vocoder menus which 
are further described in the Resynthesis, Vocoder sections below.
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■ Resynthesis menu

Icarus comes with a powerful resynthesis feature. Resynthesis means that a sound of your choice is 
analyzed and reassembled within the synthesizer. Unlike conventional sampling, where the sample is 
just a simple copy of the original sound, the resynthesized sound is a completely new, but similar 
sounding patch rebuilt from the scratch.

Icarus 3 includes a new feature capable of resynthesizing melodies.  
Resynthesis of melody imports complete phrases or melodies in wav format, automatically 
programming a patch that sounds very similar to the original. 
It reprograms the melody in the arpeggiator and creates a wavetable with the harmonic content of the
patch. After which the patches can be further tweaked, time stretched or modified.

With resynthesis there are many things possible, which are impossible with conventional samples or 
which can not properly done with them.

- Variable Pitch shifting
- Variable time stretching
- BPM syncing
- Time freezing
- Forward and backward playback with variable
speed
- Formant shifting (eliminates the 'Mickey Mouse'
effect on vocals)
- Morphing

There are many synthesizers out there, which are
advertised to be capable of 'resynthesis'. However
the results that these products give are mostly
poor: They produce heavy rumble and artifacts
when a sample isn't tuned exactly, they fail with chords, they fail with voices, they fail with many 
natural sounds, they fail with pitch slides and they are difficult to use. We have taken care of these 
problems. 
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■ How to resynthesize a sample

Click on the Resynthesis button to open its menu, select your preferred Resynthesis option and load a 
short wav sample of your choice...

  TIP  
-  Use single sounds, avoid melodies, unless you use ‘the Resynthesis of Melody’ option.
-  Try to avoid samples with other instruments or percussion in the background.
-  Recordings from monophonic sounds give better results than chords.
-  The sound quality of the processed wav file should high. 
-  Use 16 bit mono files with less than 2 seconds length. 
-  If you use very large files the processing time will be also very long.

...wait for a short moment. The synth created a new patch. OSC1 contains a wavetable which contains 
waveforms that have been resynthesized from your wav file. LFO1 now controls the WAVE position of 
this wavetable.
  TIP  Apply a Morph Mode to change the sound.

  TIP  Combine the Vocoder and Formant Morph Modes for formant shifting on vocals.

  TIP  You can resynthesize wavetables without automatically creating a new patch in the Tools menu of 
the oscillators.

The following resynthesis options are available.

◦ Create patch: Load a wav sample (no resynthesis) – Loads a wav file without applying 
resynthesis.

◦ Create patch: Resynthesis smart pitch snap – Resynthesize using Smart pitch snap 
enhances the sound quality. Select a wav file and it automatically creates a synthesizer 
patch that syncs to BPM.

◦ Create patch: Resynthesis of melody – Imports a complete phrase or melody in wav 
format, automatically programming a patch that sounds very similar to the original. It 
reprograms the melody in the arpeggiator and creates a wavetable with the harmonic 
content of the patch. After which the patches can be further tweaked, time stretched or 
modified.

◦ Create patch: Resynthesis with dynamic pitch – Automatically creates a patch which 
sounds similar to the original one. This mode analyses the pitch information of the patch 
and programs the STEP LFO with a pitch envelope.

ICARUS 3 Manual - 20 -



◦ Create patch: Resynthesis with static pitch – Creates a patch using static pitch which 
sounds similar to the original one. The default mode which gives the best results if the 
sound’s pitch doesn’t matter, otherwise use the dynamic pitch option.

◦ Create patch: Resynthesis with static pitch + PingPong Loop 100% – Similar to 'Resynthesis
with static pitch’, but uses a PingPong 100% LFO to loop the wavetable. The loop uses a 
sawtooth LFO to reloop at the end of the sample.

◦ Create patch: Resynthesis with static pitch + PingPong Loop 50% –  Similar to 'Resynthesis 
with static pitch’, but uses a PingPong 50% LFO to loop the wavetable. The loop uses a 
sawtooth LFO to reloop at the end of the sample

◦ Create patch: Resynthesis with static pitch + Repeating Loop –  Similar to 'Resynthesis 
with static pitch’, but uses the PingPong LFO to loop the wavetable. The loop uses a 
sawtooth LFO to reloop at the end of the sample

◦ Create patch: Resynthesis additive with static pitch – Works like the default Resynthesis, 
but removes all phase information and detuning from the sample. As a result you get the 
cold sound known from additive synthesizers. 

◦ Create patch: Resynthesis with static pitch for noisy sounds – Works like the normal 
resynthesis, but sometimes gives better results with very noisy sounds like flutes.

◦ Create patch: Granulator – Creates a wavetable using granular synthesis. With granular 
synthesis a sample is divided into small 'grains' with a window function. 

◦ Create patch: Time stretch large blocks – Loads a sample and timestretches or pitchshifts it
using large blocks. Large blocks produces less artifacts, but has less precise timing. Change 
the LFO1 Shape to a triangle for a forward and backward playback. Change LFO1 Speed for 
a faster or slower playback of the sound. When you set Speed to 0 you can time freeze the 
sample.  You can use the WAVE knob to change the start offset of the sound. The 
pitchwheel changes the pitch of the sample without affecting the playback speed.

◦ Create patch: Time stretch medium blocks – Loads a sample and timestretches or 
pitchshifts it using medium blocks. Medium blocks is the default mode. Change the LFO1 
Shape to a triangle for a forward and backward playback. Change LFO1 Speed for a faster 
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or slower playback of the sound. When you set Speed to 0 you can time freeze the sample. 
You can use the WAVE knob to change the start offset of the sound. The pitchwheel 
changes the pitch of the sample without affecting the playback speed.

◦ Create patch: Time stretch small blocks – Loads a sample and timestretches or pitchshifts 
it using small blocks. Small blocks has more precise timing, but also more artifacts. Change 
the LFO1 Shape to a triangle for a forward and backward playback. Change LFO1 Speed for 
a faster or slower playback of the sound. When you set Speed to 0 you can time freeze the 
sample.  You can use the WAVE knob to change the start offset of the sound. The 
pitchwheel changes the pitch of the sample without affecting the playback speed.

◦ Create patch: Beat slice drumloop 16 steps – Cuts a sample into 16 waveforms and creates
a patch which plays a BPM synced loop.

◦ Create patch: Beat slice drumloop 32 steps – cuts a sample into 32 waveforms and creates 
a patch which plays a BPM synced loop.

■ Vocoder menu

The vocoder module of Icarus offers the highest possible sound quality: It has over 500 bands and 
ultra fast envelopes.

Click on the Vocoder button, select 'Create patch:
Vocoder Poly Classic' and select a vocal sample or a
drumline in wav format. 
A complete vocoder patch is created instantly. Use the
LFO1 Speed knob to change the playback speed of the
vocoder. Use the Morph knob to shift the formants up
and down.

  TIP  If needed, apply Tools→Modify Wavetable: Maximize Volume for one or several times to boost 
the volume.

The following Vocoder options are available:

◦ Create patch: Vocoder Poly Classic – A classic vocoder sound with a sawtooth as carrier 
wave. A good choice if you want to play chords.

◦ Create patch: Vocoder Poly Robo Stack – The 90s robotic vocoder sound known from 
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many old Freestyle recordings. It uses two stacked sawtooths as carrier wave.
◦ Create patch: Vocoder Poly Breathy – A unique, breathy sounding vocoder which is only 

available in Tone2 Icarus.  A good choice if you want to play chords.

◦ Create patch: Vocoder Poly Hollow – A vocoder with a squarewave as carrier. It has a 
hollow sound.

◦ Create patch: Vocoder Poly Noise – A vocoder with noise as carrier. It sounds like 
whispering.

◦ Create patch: Solo Singer – Creates a monophonic patch which sounds like the famous 
'Cher' record 'Do you believe'.The 'Cher effect' means that singing phrase is overprocessed 
with an autotune processor to achieve an artificial sound. Use the GLIDE knob to control 
the speed of the legato. Use the Morph knob to shift the formants up and down.
  TIP  Play legatos (2 keys are pressed, one is released)

  TIP  You can make it sound even more artificial if you apply Tools→Modify Wavetable: 
Enhance Spectrum'

  TIP   What Is a vocoder? 

Simply put, a vocoder puts the ‘characteristics’ of one sound onto another. Originally designed in the 
1930s as a method of encoding a person’s voice for secure communication over a telephone network, 
it found a home in modern music during the 1970’s.

A more detailed explanation goes like this. A vocoder needs two inputs, a carrier and a modulator. The
tonal characteristics of the modulator are impressed onto the sound of the carrier. The modulator is 
usually a voice, drum loop or other percussive sound. This sound is passed through many parallel 
filters to create a ‘signature’ of the modulator from the frequency content and volume of the 
frequency components. This multi-frequency, time-varied ‘signature’ is then used to filter the carrier 
which is usually a frequency rich sustained sound (like chords played using a sawtooth wave). If you 
use a voice as the modulator the output sounds like the sawtooth wave modulated by the filter 
created by the voice
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■ Patch Browser

The Patch Browser provides an easy way to browse and listen to all of the sounds Icarus ships with. 
With an info pane to display information about the patch and a ranking system to tag your favorite 
patches.

◦ Type: Displays the current patch category / type of patch.

◦ Patch: Displays the list of patches available in the currently selected category.

◦ Info: The Info window displays all information on the selected patch, e.g. used playmode, 
synthesis type, etc..

To exit the Patch Browser, click on the X button (top right of the screen)

  TIP  Icarus banks and presets can be organized with your standard file browser. In the Icarus_sounds'   
folder you'll find the different banks as seen in Icarus' 
Both the folders and the .fxp patch files contained inside can organized / renamed and the changes 
will be displayed the next time you start Icarus.
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■ Oscillators

Icarus’ oscillators generate tones through a multiple of different methods which can later be further 
shaped using the filters and effects processors. 
Each of the three available oscillators offer a range of synthesis methods along with different play 
modes, wavetables & wave modifiers. The oscillator section holds a lot of controls so an explanation 
will be given for each section.

■ Waveform display

The waveform display is used to provide visual feedback on which waveform is loaded and displays 
the loaded wave(table) Any changes to the waveform are automatically updated & displayed here. 
By left-clicking within the waveform display you can switch between the different ways a wavetable or 
wave is displayed.
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■ Oscillator controls

The oscillator controls are the standard functions you’ll use to control an oscillator, like Volume, Pan, 
Octave….
The three oscillators have the same general controls. 

• Vol – This controls the volume of the oscillator.

• Detune – This controls the amount of detuning applied to the oscillator.

• Oct – This control allows you to select the pitch octave at which the sample will be played 
back, with a range of 8 octaves to choose from: 4 up for the positive values and 4 down for the 
negative values.

• Wave – Runs through all waveforms in the wavetable.

• Fade – When WAVE is modulated by LFO1 or another source the waveforms of the wavetable 
are cross-blended. The FADE knob controls how this cross-blending is done. 
If the knob is set to 0, the synthesizer will switch between the waveforms without any cross-
blending. This gives a hard, clicking sound and reduces the CPU load. When FADE is set to 
100% the waveforms are smoothly crossfaded. A value of 50% is a combination of both. It can 
help to enhance the expression and clarity of the wavetable.

• Morph – The morph knob adjusts the way the selected morph mode affects the wavetable. 
Morph modes are selected using the Morph mode menu (found just above the morph knob) 
and are processed in realtime, this means that you hear all changes immediately and you can 
route any modulation source to MORPH within the matrix.

• Pan – The pan control allows you to position the sound in the stereo field (left-middle-right)

• Phase – The phase control changes the start phase of the oscillator's waveform.

• Semi – Semi changes the oscillator tune in semitones.

• Fine – This knob controls the fine tuning of the oscillator. The range is plus or minus 100 cents. 
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There are 100 cents per semitone. 
• LFO1 – The LFO1 knob is used to determine the amount of modulation LFO1 should apply to 

the Wave control.

• LFO2 –  The LFO2 knob is used to determine the amount of modulation LFO2 should apply to 
the Morph control.

  TIP   Saving CPU 

If you don’t need an oscillator in a patch – turn it off. You will save CPU processing power. The same 
goes for any filters you don’t need. If you don’t need it, turn it off!

■ Oscillator Playmodes

Icarus features a large amount of oscillator playmodes, just beneath the waveform display on the left 
you'll find the Play Mode menu.
Note that once a play mode is selected, visual feedback in the shape of multiple arrows will show the 
amount of oscillator detuning.
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■ Playmodes

◦ Mono – Single oscillator. This is the classic mode which is used by conventional synthesizers

◦ Stereo – Stereo mode.

■ HyperSaw

◦ HyperSaw 3, 5, 7, 9 – Several detuned oscillators play at the same time. Unlike 
conventional Hypersaw synthesizers, the Hypersaws in Icarus are phase optimized. This 
means that the amount of beating is minimized statistically. As a result you get a sound 
which suffers from less gain peaks and has more bottom. The Hypersaw oscillators of 
conventional synthesizers use only sawtooths. In Icarus you can combine this mode with 
any kind of waveform or wavetable. The detune knob controls the amount of detuning.

◦ SuperSaw – Ninedetuned oscillators play at the same time. This mode provides the classic 
'Trance' sounds from the late 90s. Unlike conventional synthesizers with Supersaw you can 
combine this mode with any kind of waveform or wavetable. The detune knob controls the 
amount of detuning.

■ Stereo Hypersaw 

◦ HyperStereo 4, 6, 8, 10 – Several detuned stereo oscillators play at the same time. The 
oscillators are phase optimized. This means that the amount of beating is minimized 
statistically. As a result you get a sound which suffers from less gain peaks and which has 
more bottom. The detune knob controls the amount of detuning.

■ Unison

◦ Unison 2x – Two detuned oscillators are stacked. The detune knob controls the amount of 
detuning.

◦ Unison 4x – Four detuned oscillators are stacked. The detune knob controls the amount of 
detuning.

◦ Unison 4x Stereo – Four detuned stereo oscillators play at the same time. The detune knob
controls the amount of detuning.

■ Stack
◦ Stack 2:1 Octave – Two detuned oscillators are stacked. The second oscillator plays one 
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octave higher. The detune knob controls the amount of detuning.

◦ Stack 3:1 – Two detuned oscillators are stacked. The second oscillator plays one octave and
a fifth higher. The detune knob controls the amount of detuning.

◦ Stack 4:1 – Two detuned oscillators are stacked. The second oscillator plays two octaves 
higher. The detune knob controls the amount of detuning.

◦ Stack 5:1 – Two detuned oscillators are stacked. The frequency of the second oscillator is 
five times higher. The detune knob controls the amount of detuning.

◦ Stack 3:2 Fifth – Two detuned oscillators are stacked. The second oscillator plays a fifth 
higher. The detune knob controls the amount of detuning.

◦ Stack 5:2 – Two detuned oscillators are stacked. The second oscillator plays 2.5 times 
higher. The detune knob controls the amount of detuning.

◦ Stack 4:3 Quart – Two detuned oscillators are stacked. The second oscillator plays 1.33 
times higher. The detune knob controls the amount of detuning.

◦ Stack 5:3 – Two detuned oscillators are stacked. The second oscillator plays 1.66 times 
higher. The detune knob controls the amount of detuning.

◦ Stack 5:4 Major – Two detuned oscillators are stacked. The second oscillator plays a major 
third higher. The detune knob controls the amount of detuning.

◦ Stack 6:5 Minor – Two detuned oscillators are stacked. The second oscillator plays a minor 
third higher. The detune knob controls the amount of detuning.

◦ Fifth Oct – Three detuned oscillators are stacked. The second oscillator plays an octave 
higher. The third oscillator plays an octave and a fifth higher. The detune knob controls the 
amount of detuning. 

◦ Octave 4x –Two detuned oscillators are stacked. The second oscillator plays one octave 
higher. The detune knob controls the amount of detuning.

◦ Octave 4x Stereo – Four detuned stereo oscillators are stacked. The second pair plays one 
octave higher. The detune knob controls the amount of detuning.
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■ Autochord

◦ Third Maj/Min – Two detuned oscillators are stacked. The second oscillator plays a minor 
or major third higher. The detune knob controls the amount of detuning.

◦ Third Maj/Min 2 – Three detuned oscillators are stacked. The second oscillator plays an 
octave higher. The third oscillator plays a minor or major third higher. The detune knob 
controls the amount of detuning.

◦ Third Maj/Min 3 – Three detuned oscillators are stacked. The second oscillator plays an 
octave higher. The third oscillator plays an octave and a minor or major third higher. The 
detune knob controls the amount of detuning.

◦ Chord 1 – Plays a major or minor chord. The detune knob controls the amount of detuning.

◦ Chord 2 – Plays a major or minor chord and one octave lower. The detune knob controls 
the amount of detuning. 

■ Flanger

◦ Flange 3x – Three slightly detuned oscillators are stacked to achieve a flanging effect. The 
detune knob controls the modulation speed.

◦ Flange 5x – Five slightly detuned oscillators are stacked to achieve a flanging effect. The 
detune knob controls the modulation speed.

◦ Flange Stereo – Six slightly detuned oscillators are stacked to achieve a stereo flanging 
effect. The detune knob controls the modulation speed.

■ Tuning

◦ Semi  –  Single oscillator is playing, the detune knob controls the semitones.

◦ Interval – Single oscillator is playing. The detune knob controls the harmonic interval. If it is
set to 0 it will play the base frequency. Higher values result in a frequency which is 
2,3,4,5,6,7 or 8 times higher. 

◦ Pitch –Single oscillator is playing, the detune knob controls the pitch.
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■ Wavetable menu

This menu is used to select which wavetable the current oscillator should use. External wavetables can
be loaded using the Tools menu found on top of the Oscillator panel. 
The two arrow shaped controls found on top-next to the oscillator label are used to navigate forward /
backward through the Wavetable list.
Once a wavetable is loaded you can use the Wave knob to run through the wavetable, or likewise 
position your mouse over the waveform display to use the mousewheel to run through the wavetable.

Left-clicking on the waveform / table display will change the way the wavetable / shape is displayed. 

Once a wavetable is loaded a small arrow inside the wavetable name field will display the current 
position within the wavetable.
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■ Morphmodes

The morph modes are different playback modes for the wavetables. The morph knob varies the way 
how the morph mode affects the wavetable. Next to the WAVE knob it provides another dimension to 
change the oscillator's sound. 
No other synthesizer offers as many playback modes for wavetables as Icarus does. All morph modes 
are processed in realtime, which means that you hear all changes immediately and you can route any 
modulation source to MORPH and WAVE within the matrix.

Once a morph mode is selected a small arrow inside the morph mode name field will display the 
number of quantized steps. 

  TIP  You can apply an unlimited number of morphs to the wavetable! As a result you'll get easy access 
to literally an unlimited number of different wavetables. 
This feature is unique to Icarus and not available in any other synthesizer. Most morph modes can be 
pre-rendered to a wavetable by using the Tools menu, use: 
'Tools → Apply Morph → Apply Morph to wavetable' or  'Tools → Apply Morph → Apply Morph Sweep
to current waveform'
As soon as you pre-rendered the MORPH, the playback mode will switch to 'None / Partial' and you 
can apply another Morph mode. 
You can undo your changes with 'Tools → Undo/Redo Wavetable edit'.
  TIP  As soon as you pre-rendered a morph to a wavetable you can use WAVE to morph, use LFO1 knob
to modulate the morph and use FADE to define whether you want a quantized or smooth transitions.
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  TIP  When you move the MORPH knob you will notice audible stepping on some morph modes 
(Bandlimit, Ringmod, Bandpass, ...). This stepping is useful for many sounds. If you want smooth 
transitions select 'Tools → Apply Morph Sweep to Wavetable'. Set the 'FADE' knob to 100. Then 
use WAVE for a smooth transition. 

The following Morph modes are available.

None / Partial  – This is the default mode for wavetable playback. If the value of the MORPH knob is 
set to 0 the original wavetable, without any changes applied, is played back. Larger values remove 
partials from the signal.

  TIP  When you move the MORPH knob you will notice an audible stepping. If you want 
smooth transitions select 'Lowpass fade' as morphmode instead.

  TIP  This mode offers the highest sound quality and doesn't need much CPU. You should 
use this mode, except you want to morph the wavetable in realtime or except the case that
you are using morphmodes which use fixed formant frequencies. 

■ PW / PhaseDistort

◦ PW – Applies pulsewidth modulation to the oscillator. MORPH controls the pulsewidth. 
When MORPH is set to 0 it will remove all even harmonics. As a result a sawtooth will be 
turned into a square wave. When MORPH is set high values a sawtooth will be turned into 
an impulse.

◦ PhaseDist PW – Phase Distortion with pulsewidth control is applied to the oscillator. Unlike
the morphmode PW it does not change the waveform when MORPH is set to 0. 

  TIP  Select a square wave as waveform and set the LFO2 knob to 100 and MORPH to 0 for 
classic PWM.

◦ PhaseDist Saw – Classic Phase Distortion which is mostly known from the old Casio synths. 
It morphs a sine wave to a sawtooth.
  TIP  Select a sine wave and set the LFO2 knob to -100, MORPH to 100.

◦ PhaseDist Squ – Classic Phase Distortion which morphs a sine wave to a square wave.

◦ PhaseDist X2 – Phase Distortion which morphs a waveform to a waveform with double 
frequency.

◦ Mirror – Mirrors the waveform in the middle. When MORPH is set to 0 it will remove all 
even harmonics. As a result your will get a hollow sound.

◦ Grunge – Adds additional harmonics to the oscillator.
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  TIP  If you want smooth transitions select 'Tools → Apply Morph Sweep to Wavetable'. Set 
the 'FADE' knob to 100. Then use WAVE to morph the sound.

■ FM

◦ FM Sine – The wavetable is FM modulated with a sine wave oscillator. 

  TIP  Use the FM Sine modes together with a sine wave or another dark waveform. Use the 
LFO2 knob to modulate. 
Note that the FM modes in Icarus are real frequency modulation, not PM (phase 
modulation). Nearly all conventional 'FM' synthesizers (except Tone2 Nemesis) in fact do 
only PM, which is more easy to process, but doesn't give musically useful sounds on 
complex waveforms.

◦ FM Sine 2x – The wavetable is FM modulated with a sine wave oscillator with double 
frequency. It has a hollow sound.

◦ FM Sine 3x – The wavetable is FM modulated with a sine wave oscillator with triple 
frequency. It has a bell-like sound.

◦ FM Square – The wavetable is FM modulated with a square wave oscillator.  

◦ FM Saw – The wavetable is FM modulated with a saw wave oscillator. 

◦ FM FM<-Osc3 – FM (PM) between Icarus’ own oscillators. 
Select FM←Osc1 inside of oscillator2’s Morphmode menu to modulate Osc2 with Osc1. 
Or FM←OSC3 inside of oscillator1’s Morphmode menu to modulate Osc1 with Osc3.

■ Sample

◦ Sample – Single sample playback, note that wavetable controls will not have an effect in 
this mode.

◦ Sample Loop –  Looped sample playback, note that wavetable controls will not have an 
effect in this mode.

◦ One Shot Wave – This mode play the waveform of the oscillator only for a single time. It is 
useful to add transients to the attack sound of a patch. It can also be used to build drum 
sets with short samples.
  TIP  Icarus can handle very complex waveforms. It's even possible to load short samples 
(less then 2048 samples samplelength) as a waveform to a wavetable. Simply drag&drop a 
wav file to the 3D display of the oscillator. You can also use 'Tools->Load Waveform to 
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current WAVE position'.
  TIP  There is a 'Drumset' patch within the Templates directory which makes use of these 
features. We included several 'Drumset' wavetables to Icarus. Every waveform in these 
wavetables contains a separate drum sample. The MORPH knob selects the sample.

  TIP  It's even possible to map different waveforms / samples to different keys on the 
keyboard. Load a 'Drumset' as wavetable then select 'Key C C# D...' as matrix source, select 
'Wave 1' as matrix target and set 'matrix send' to 100. 

■ Harmonic

◦ Harmonic Key – A partial morph with smooth transitions and key tracking.
  TIP  Use the LFO2 knob for cool morphs.

◦ Harmonic – A partial morph with smooth transitions. The sound of the wavetable will 
change in a way that the frequency content sounds similar, no matter what key you press 
on the keyboard.
  TIP  Use the LFO2 knob for cool morphs.

◦ Hollow1-4 Key – A partial morph with smooth transitions and key tracking. It has a hollow 
sound.

◦ Hollow – A partial morph with smooth transitions and a hollow sound. The sound of the 
wavetable will change in a way that the frequency content sounds similar, no matter what 
key you press on the keyboard.
  TIP  With Hollow modes use the LFO2 knob for unique filter sweeps.

■ Formant

◦ Formant – This mode is useful for speech synthesis, synced sounds and sweeps. The sound 
of the wavetable will change in a way that the frequency content sounds similar, no matter 
what key you press on the keyboard.
Low values of the MORPH knob result in a darker sound, high values result in sounds with 
lots of energy in the high spectrum.
  TIP  Use the LFO2 knob for cool morphs.

◦ Formant Cross – Similar to Formant, but with a softer sound.

◦ Vocoder – This mode is intended to be used together with wavetables created by the 
vocoder. however it is not limited to this purpose and can give interesting results with 
other wavetables. 
In this mode the sound will change in a way that the frequency content sounds similar, no 
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matter what key you press on the keyboard. It does eliminate the 'mickey mouse effect' 
which is known when you you play back a vocal sample with high pitch and gives you 
independent control over pitch and formant frequency. 
Low values of the MORPH knob shift the formant frequencies down and result in a devil-
like voice. High values shift the formant frequencies up and give a smurf-like sound.

  TIP  Click on the Vocoder tab, select a Vocoder mode and load a vocal sample to create a 
vocoder wavetable. Then use the MORPH knob to alter the sound.

◦ Granulator – This mode can be used to pitchshift or to timestretch samples. This mode is 
intended to be used together with wavetables created by the granulator in the resynthesis 
section. However it is not limited to this purpose and can give interesting results with other
wavetables. The MORPH knob controls the pitch of the sample which is played back.

  TIP  Click on the Resynthesis tab, select Create Patch: Granulator and load a sample to 
create a granulator wavetable. Then use the MORPH knob to alter the sound.

■ Filtered

◦ Lowpass Fade – A spectral lowpass filter with at least 80dB is applied to the wavetable. 
Unlike conventional filters it doesn't suffer from phase shift and gives extremely precise 
results. It has a very unique sound and is excellent for punchy bass sounds with lots of 
pressure. This filter is exclusive and only available in Tone2 Icarus and Tone2 Nemesis.
  TIP  Use the LFO2 knob and MORPH to modulate the filter cutoff.

◦ Highpass Fade –  A spectral highpass filter with at least 80dB is applied to the wavetable. 
This filters is exclusive and only available in Tone2 Icarus.

◦ Highpass – A steppy spectral highpass with over 120dB(!) is applied to the wavetable.

◦ Bandpass 1oct – A steppy spectral bandpass with over 120dB(!) and one octave bandwidth 
is applied to the wavetable.
  TIP  If you want smooth filter sweeps select 'Tools->Apply Morph Sweep to Wavetable'. Set 
the 'FADE' knob to 100. Then use WAVE to control the filter cutoff.

◦ Bandpass 2oct – A steppy spectral bandpass with two octaves bandwidth is applied to the 
wavetable.
  TIP  If you want smooth filter sweeps select 'Tools->Apply Morph Sweep to Wavetable'. Set 
the 'FADE' knob to 100. Then use WAVE to control the filter cutoff.

◦ Bandstop 1oct – A steppy spectral bandstop with over 120dB(!) and one octave bandwidth 
is applied to the wavetable.
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◦ Bandstop 2oct – A steppy spectral bandstop with over 120dB(!) and two octaves 
bandwidth are applied to the wavetable.

◦ Sine Fade – Crossfades the waveform to a sine wave.
  TIP  You can use this if a waveform doesn't have enough 'bottom' or doesn't sound 'warm' 
enough.

◦ F0 Cut Fade – Removes the first partial.
  TIP  You can use this to make a waveform sound more bright.

■ AM / Ringmod

◦ Ringmod Key – Ringmodulation with key tracking applied to the wavetable.

◦ Ringmode Fade – Ringmodulation with a fixed frequency applied to the wavetable. The 
sound of the wavetable will change in a way that the frequency content sounds similar, no 
matter what key you press on the keyboard.
  TIP  This mode sounds similar to a  filter sweep. Use the LFO2 knob and MORPH to 
modulate the 'filter cutoff'.

◦ Ringmod – Ringmodulation with key tracking and stepping applied to the wavetable.

◦ AM Key – Amplitude modulation with key tracking applied to the wavetable.

◦ AM Fade – Amplitude modulation with a fixed frequency is applied to the wavetable. The 
sound of the wavetable will change in a way that the frequency content sounds similar, no 
matter what key you press on the keyboard.
  TIP  Use the LFO2 knob to modulate it.

◦ AM – Amplitude modulation with key tracking and stepping is applied to the wavetable.

◦ AM←OSC3 – Amplitude Modulation between Icarus’ own oscillators. 
Select AM←Osc1 inside of oscillator2’s Morphmode menu to Amplitude Modulate Osc2 
with Osc1.
Or AM←OSC3 inside of oscillator1’s Morphmode menu to Amplitude Modulate Osc1 with 
Osc3.

■ Waveshape

◦ Waveshape –  A waveshaper is applied to the wavetable which gives FM-like sounds.
  TIP  Use the LFO2 knob to modulate it.

◦ Shape←OSC3 – Waveshaping between Icarus’ own oscillators. 
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Select Shape←Osc1 inside of oscillator2’s Morphmode menu to Shape Osc1 with the 
waveform of Osc2.  Or Shape←OSC3 inside of oscillator1’s Morphmode menu to shape 
Osc3 with the waveform of Osc1.

■ Sync

◦ Sync Squ Key –  Applies hard sync with key tracking to the oscillator. This mode is useful for 
synced sounds and sharp sounding sweeps.

◦ Sync Squ – Applies hard sync to the oscillator. This mode is useful for speech synthesis, 
synced sounds and sweeps. The sound of the wavetable will change in a way that the 
frequency content sounds similar, no matter what key you press on the keyboard.

◦ Sync Saw Key – Applies hard sync with key tracking to the oscillator. This mode is useful for 
synced sounds and sharp sounding sweeps.

◦ Sync Saw –Applies hard sync to the oscillator. This mode is useful for speech synthesis, 
synced sounds and sweeps. The sound of the wavetable will change in a way that the 
frequency content sounds similar, no matter what key you press on the keyboard.

  TIP  Use the LFO2 knob to modulate and for cool morphs.

■ Comb

◦ Comb 2x – Applies a comb filter with 2 stages to the oscillator.

◦ Comb 3x – Applies a comb filter with 3 stages to the oscillator.

  TIP  Set the LFO2 knob to 100 and MORPH to 0 for beating strings.

■ Stack / Chord 

◦ Stack Octave+ – Stacks an oscillator and another one which is one octave higher. MORPH 
controls the amount of phase shift between both oscillators.
  TIP  Set the LFO2 knob to 100 and MORPH to 0 to get interesting sounds.

◦ Stack Octave- – Stacks an oscillator and another one which is one octave higher and 180 
degree phase shifted. MORPH controls the amount of phase shift between both oscillators.
When MORPH is set to 0 it will remove many even harmonics. As a result this mode has a 
more hollow sound then 'Stack Octave+'.
  TIP  Set the LFO2 knob to 100 and MORPH to 0 to get interesting sounds.

◦ Stack Harmon+ – Stacks an oscillator and another one which is two, three, four, five, six, 
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seven or eight times higher. MORPH controls the harmonic relationship between both 
oscillators.
  TIP  If you want smooth transitions select 'Tools->Apply Morph Sweep to Wavetable'. Set 
the 'FADE' knob to 100. Then use WAVE to morph the sound.

◦ Stack Harmon- – Stacks a 180 degree phase shifted oscillator and another one which is 
two, three, four, five, six, seven or eight times higher. MORPH controls the harmonic 
relationship between both oscillators. This mode has a more hollow sound then 'Stack 
Harmonic+'.

◦ Stack Power – Stacks several oscillators which are two, three and four times higher.
  TIP  Use this mode together with sinoid waveforms to build organs.

◦ Chord 2x – Two stacked oscillators play a chord. The MORPH knob selects the type of 
chord, like major, minor, fifth,..

◦ Chord 3x – Three stacked oscillators play a chord. The MORPH knob selects the type of 
chord, like major, minor, fifth,..

◦ Interval – Shifts the base frequency of the oscillator. The MORPH knob selects the 
harmonic relationship (1x-16x). This mode can be useful for building custom chords.

◦ Jodel Chip – Plays a very fast arpeggiator to mimic a chord. This effect is known from the 
chiptunes on vintage computers like the C64. MORPH controls the type of chord. We called 
this mode 'Jodel' because Tone2 is a company from Bavaria.
  TIP  Set the OCT knob to 0 or -1 to lower the speed of the chord.

■ Noise

◦ Noise White – Plays white noise.

◦ Noise Pink – Plays pink noise. Pink noise has more energy in the low spectrum.

◦ Noise Tuned – Plays noise, which base frequency follows the key that you currently play.
  TIP  Use this oscillator for the percussion of chiptunes.

■ Lofi

◦ Spirit – The pitch of the oscillators is frequency modulated with noise. This mode gives a 
breathy sound. MORPH controls the amount of detuning.
  TIP  Use this mode to build choirs and to make voices sound more natural.

◦ Analog – The oscillator sounds like an analog one. It has a muffled sound and suffers from 
drift and saturation. MORPH controls the amount of distortion.
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  TIP  Select a sawtooth as waveform and use this mode together with the analog filters for 
an authentic emulation of vintage synths.

◦ Downsampling – The oscillator is played back with a lower sample rate. As a result the 
sound quality is reduced. It has a characteristic 'digital', but also interesting sound. 
Morph controls the amount of undersampling.
  TIP  This mode only need very low CPU. It can be used to reduce the CPU requirements 
without much quality loss as long as you don't overdo it.

  TIP  With high MORPH values this mode can be used to create droid-style vocaloids.

◦ Aliasing – The oscillator is played back in an ugly way with a lower sample rate. As a result 
the sound quality is reduced and disharmonic frequencies are added. It has a characteristic 
'cheap digital' sound. MOPRH controls the amount of undersampling.
  TIP  This mode can be used for effect sounds or if you want to mimic the sound of cheap 
digital hardware.
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■ Oscillator menu

The Oscillator menu offers access to several main oscillator controls as well as the Wavetable editor 
and the Tools menu

■ Wavetable navigation arrows
The two arrow shaped controls found on top-next to the oscillator label are used to navigate forward /
backward through the Wavetable list.

■ Wavetable Editor
The editor button opens the Wavetable editor, which can be used to further manipulate and shape 
your wave & wavetable. More on this in the Wavetable Editor chapter. 

■ Tools menu
The Tools menu provides access to a host of Wave(table) load, save & edit options as well as Vocoder 
and Resynthesis load / save / generation options. Options are further explained below. 

■ Reset

◦ Reset all Oscs – Resets all oscillator settings (Oscillator 1,2,3) and loads the default 
wavetable.

◦ Reset current Osc – Resets the current oscillator settings and loads the default wavetable.

■ Copy

◦ Copy current Osc to Osc1 – Copies all settings from the current oscillator to oscillator 1.

◦ Copy current Osc to Osc2 – Copies all settings from the current oscillator to oscillator 2

◦ Copy current Osc to Osc3 – Copies all settings from the current oscillator to oscillator 3.

■ Undo/Redo Wavetable Edit – Use this to compare & undo changes made with the Tools menu.
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■ Load / save

◦ Load Wavetable (N*2048 samples, Icarus, Serum, Falcon) – Loads a wavetable which has 
the Icarus wav format (N*2048 samples) to the currently selected oscillator. It does also
  TIP  You can also drag & drop an Icarus wavetable to the 3D display of the oscillator to load 
it

◦ Load Waveform to current WAVE position – Copies all settings from the current oscillator 
to oscillator 2 Loads a waveform to the wavetable slot, which is selected by the WAVE 
knob. A waveform is a wav file with 2-2048 sample length and contains a single cycle 
waveform. If you load a larger wav file a waveform is automatically resynthesized from the 
middle of this sample.
  TIP  Icarus can handle very complex waveforms. It's even possible to load short samples 
(less than 2048 samples sample length) as a waveform to a wavetable. This can be useful to
build a drum set or for transient attack sounds.

  TIP  Icarus supports drag & drop of  one or several wav files to the 3D display of the 
oscillator. When you use drag & drop the waveform is loaded to the wavetable slot, which 
is currently selected by the WAVE knob.

◦ Save Wavetable – Dumps the wavetable of the currently selected oscillator to disc. 
Icarus wavetables are compatible with many other synthesizers and audio editors, also 
from other companies. While many audio companies encrypt their wavetables to prevent 
that they can be copied we think that wavetable synthesis can only make a step forward if 
there is an interchangeable, open and well documented file format that anyone can use 
and edit.
An Icarus wavetable is in the common wav file format (16 bit mono) and contains all 
waveforms in series. Each single-cycle waveform is exactly 2048 samples long. A wav file 
containing a wavetable with 3 waveforms has a length of 3 x 2048 samples. A wavetable 
can consist of 1 to 256 waveforms. 
  TIP  Icarus can create an unlimited amount of wavetables!

■ Create Wavetable

◦ Synthesize a random Wavetable – The wavetable of the currently selected oscillator is 
replaced with a new one. Use the WAVE knob to select the currently played waveform.
  TIP  A wavetable can contain also just one single waveform. Then it can't be morphed with 
the WAVE knob, but it can be imported to a slot of  a wavetable.

  TIP  You can save a wavetable, use an external editor, modify it and load it back into Icarus.

  TIP  If you want to export not the complete wavetable, but a single-cycle waveform use 
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'Tools->Trim Wavetable: Pick current waveform' to create a wavetable with only one 
waveform first. Then save the wavetable.
  TIP  For quick access to your own wavetables you can add your own custom files to the 
factory content of Icarus. When Icarus is loaded all wavetables within the 
Icarus_wavetables directory are scanned and displayed within the oscillators. 
The Icarus wavetables are stored as wav files within the Icarus_wavetables directory. On PC
this directory can be found within your vstplugins directory. On Mac it is within 
Library/Audio/Plug-ins.

  TIP  Icarus patches are in fxp format. The fxp files contain the current patch setting, but do 
also contain the wavetable data. 
The wavetable data is also stored directly within your songs. You don't have to care or be 
scared about the content of the Icarus_wavetables directory. Even if you should 
accidentally delete all factory wavetables, your songs and all Icarus patches will not be 
broken and continue to work.

■ Resynthesis

◦ Resynthesis smart pitch snap – Analyzes a wav file and resynthesizes a wavetable. The 
wavetable of the currently selected oscillator is replaced with the new one. Smart Pitch 
snap enhances the sound quality. Select a wav file and it automatically creates a 
synthesizer patch which syncs to BPM.

◦ Resynthesis stat pitch – Analyzes a wav file and resynthesizes a wavetable. The wavetable 
of the currently selected oscillator is replaced with the new one.
  TIP  Click on the RESYNTHESIS button and select 'Create patch: Resynthesis' to create a 
complete patch which sounds quite similar to the original wav file.

  TIP  Use mono wav files in high quality. If the original sample sounds crappy the results of 
the resynthesis will also sound crappy.

  TIP  Once you resynthesized a wav file you can use the WAVE knob and LFO1 to time-
stretch it.

◦ Resynthesis additive – Works like the previous one, but removes all phase information and 
detuning from the sample. As a result you get the cold sound known from additive 
synthesizers.
  TIP  You can use the spectral editor to change the partials and turn Icarus into a complete 
additive synthesizer!

  TIP  Click on the RESYNTHESIS button and select 'Create patch: Additive Resynthesis' to 
create a complete patch which sounds quite similar to the original wav file.
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◦ Resynthesis for noisy sounds – Works like the normal resynthesis, but sometimes gives 
better results with very noisy sounds like flutes.

◦ Resynthesis Note=C4→C0 – In these modes Icarus doesn't detect the pitch of the samples 
automatically. The sample that you load must be tuned exactly to C4,C3,..
  TIP  This mode can be useful if you recorded synthesizer sounds.

◦ Granulator – Analyzes a wav file and prepares a wavetable for the use with the Granulator 
Morph Mode. The wavetable of the currently selected oscillator is replaced with the new 
one.
  TIP  Click on the RESYNTHESIS button, select 'Create patch: Granulator' and select a sample
to create a complete granular patch instantly. Use the Lfo1 SPEED knob to change the 
speed of the sample. Use the MORPH knob to change the pitch of the sample.

■ Vocoder

◦ Vocoder Saw – Analyzes a wav file and prepares a wavetable for the use with the Vocoder 
Morph Mode. The wavetable of the currently selected oscillator is replaced with the new 
one. 
The vocoder module of Icarus offers the highest possible sound quality: It has over 500 
bands and ultra fast envelopes.
  TIP  Click on the VOCODER button, select 'Create patch: Vocoder' and select a vocal sample
to create a complete vocoder patch instantly. Use the Lfo1 SPEED knob to change the 
speed of the vocoder sample.  speed of the sample. Use the MORPH knob to change the 
pitch of the sample.

  TIP  Use 'Vocoder' as Morph Mode and the MORPH knob to change the formant frequency.

  TIP  You can apply 'Tools→Modify Wavetable: Maximize Volume' for one or several times to
boost the wavetable’s volume.

◦ Vocoder Square – Is like Vocoder Saw mode, but the resulting wavetable has a hollow 
sound. Use this mode to emulate a vocoder with a square wave as carrier.

◦ Vocoder Silky – Is like the Vocoder Saw mode, but the resulting wavetable has a silky 
sound.

◦ Vocoder Noise – Is like the Vocoder Saw mode, but the resulting wavetable has a noisy 
sound. Use this mode to emulate a vocoder with noise as carrier. 
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■ Trim Wavetable 

◦ Pick current waveform – Only the waveform which is selected by the WAVE knob remains. 
All other waveforms within the wavetable are thrown away.
  TIP  A wavetable, which contains just one single waveform, can't be morphed with the 
WAVE knob. Use 'Tools→Extend Wavetable: Add one slot' to extend the wavetable with 
one additional waveform slot.

  TIP  If you want to export not the complete wavetable, but a single-cycle waveform use 
'Tools→Trim Wavetable: Pick current waveform' to create a wavetable with only one 
waveform first. Then save the wavetable.

  TIP  If your patch only uses a single waveform which is part of a large wavetable, you can 
use this function to reduce the size of your songs and the size of the fxp after saving.

◦ After current waveform – All waveforms behind the one selected by the WAVE knob are 
thrown away. 

◦ Before current waveform –All waveforms before the one selected by the WAVE knob are 
thrown away. 

■ Extend Wavetable

◦ Add one slot – Adds an additional slot to the end of the wavetable.
  TIP  A wavetable, which contains just one single waveform, can't be morphed with the 
WAVE knob.

■ Modifiy Wavetable

◦ Tone warmer 1.5dB/Oct – Reduces the volume of high harmonics.
  TIP  Use it for a more 'analog' and warm sound or if a wavetable sounds too 'sharp'.

  TIP  You can apply this for several times for an even more warm sound. 

◦ Tone brighter 1.5dB/Oct – Boosts the volume of high harmonics.
  TIP  Use it for supersaw sounds or if a wavetable sounds too muffled.

  TIP  You can apply this for several times. 
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◦ Silky – The wavetable sounds more silky and noisy.
  TIP  Use this for string sounds.

◦ Square – All even harmonics get removed. As a result a sawtooth will be turned into a 
hollow sounding square wave.
  TIP  If you don't like the results you can undo it with 'Tools→Undo/Redo Wavetable edit'.

◦ Denoise – Noise is removed from the wavetable. Sometimes the resulting wavetable does 
have more 'character'
  TIP  If you don't like the results you can undo it with 'Tools→Undo/Redo Wavetable edit'.

◦ Add Noise – Adds some garbage to the wavetable.
  TIP  You can apply this for several times for more intensity. 

◦ Optimize phases – When you morph trough a wavetable with the WAVE knob you 
sometimes can hear some rumbling or detuning. After applying this one rumbling is the 
reduced and the detuning is removed.

◦ Enhance Spectrum – The resulting wavetable mostly has more 'character'.

◦ Maximize Volume – Waveforms with low volume are boosted.
  TIP  You can apply this several times for more intensity.

■ Apply Morph

◦ Apply Morph to Wavetable – This is a very powerful feature which is unique to Icarus and 
not available in any other synthesizer. It allows you to apply an unlimited number of 
morphs to a wavetable! As a result you get an easy access to an literally unlimited number 
of different wavetables.  
All morph modes can be pre-rendered to a wavetable by using 'Tools→Apply Morph to 
Wavetable'. The currently selected value of the MORPH knob is used as a parameter for the
rendering. After rendering the old wavetable is replaced with a new one. 
The playback mode will switch to the default 'None / Partial' which doesn't alter the sound 
anymore. Please note that the morphing is done with the WAVE knob instead of the 
MORPH knob now. Get ready to apply another Morph mode!
  TIP  You can undo your changes with 'Tools->Undo/Redo Wavetable edit'.

  TIP  Use the FADE knob to define how steppy transitions between waveforms are.

◦ Apply Morph Sweep to  current Waveform – This one works similar to the previous one, 
but with a little different rendering parameters. 
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The waveform which is currently selected by the WAVE knob is picked. A wavetable with 
many waveforms, which replaces the old one, is created. The first slot sounds like the 
MORPH knob set to 0, the last slot sounds like the MORPH knob set to 100. 
The playback mode will switch to the default 'None / Partial' which doesn't alter the sound 
anymore. Please note that the morphing is done with the WAVE knob instead of the 
MORPH knob now. Get ready to apply another Morph mode!
  TIP  You can undo your changes with 'Tools→Undo/Redo Wavetable edit'.

  TIP  Use the FADE knob to define how 'steppy' transitions between waveforms are.

  TIP  You can use this feature to create smooth filter sweeps and soft transitions for Morph 
modes which are 'steppy' like 'Bandpass 1oct'.

■ KEY
Switches the oscillator’s keyfollow mode to On / Off.
■ ON
Switches the current oscillator to On / Off.
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■ Wavetable editor

The Wavetable editor offers a wide range of tools and options to edit your wavetable using waveform, 
spectrum and phase editors. With the help of these tools you can further shape your wavetable or 
single wave any way you want to.

The editor screen is split into several sections, which we'll describe in more detail below.

■ Wavetable Strip Display

The Wavetable Strip display provides you with an easy overview of your wavetable, displaying all of 
the wavetable's slots. An Icarus wavetable contains all waveforms in series and consists of 1 to 256 
waveforms.
Select a single waveform  by clicking inside the wavetable strip. The currently selected and displayed 
waveform is blue. You can also select a block of several waveforms if you click on the wavetable strip 
and move your mouse, the selected waveforms are blue or red, the currently displayed waveform is 
blue.  To add a new slot click on the plus sign at the end of the wavetable. The magnifier icons found 
on the top right allow you to zoom in or out of your wavetable.
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Just below the wavetable strip, two preview keyboards are provided to listen to either the complete 
wavetable or currently selected wavetable slot, the left keyboard is used to play the wavetable, 
whereas the right keyboard will only play back the selected slot. 
A speed control (found in the middle of these keyboards) is provided to set the wavetable's playback 
speed.

Drag & Drop
You can drag & drop a wav file which contains a wavetable, waveform (a wave with a single cycle 
waveform - 2048 samples length or less) or audio data to a slot of the wavetable strip. Icarus will load 
the waveform to that specific slot.
You can also drag & drop several wave files which contain single cycle waveforms (2048 samples 
length or less)  to a slot of the wavetable strip. Icarus will replace all slots, followed by this slot with 
the new waveforms.
You can INIT a new wavetable (Create Wavetable: Saw Square Sine) and then drag & drop several 
waveforms to the first slot to create a custom wavetable.

Drag & Drop on waveform display
If you drag & drop a waveform to the large blue waveform display, Icarus will load the waveform to the
currently displayed wavetable slot.
 You can also drag&drop several wave files which contain single cycle waveforms (2048 samples length
or less)  to the waveform display. Icarus will replace all slots, which are following the currently 
displayed waveform, with the files.

■ Wavetable Tool & Options section

The Tool / Options section gives you access to all wavetable edit, file and initialization functions. 
Use the tool section to create & edit your own wavetable or import a wavetable from disc.

      The following tools & options are offered.

• ■ File – The file menu contains all wavetable / wave load and save options.

◦ Load Sample / Wavetable (N*2048 samples, Icarus, Serum, Falcon) – Loads 
a wavetable in the Icarus wav format (N*2048 samples) 
It also works with wavetables from synths like Serum or Falcon.

◦ Load Single Waveform to selection (Icarus, Galbanum,..) – Loads a 
waveform to the selected wavetable slot.

◦ Save Wavetable – Saves the wavetable to disc. Icarus wavetables are 
compatible with many other synthesizers and audio editors 
from other companies. 

ICARUS 3 Manual - 49 -



An Icarus wavetable is in the common wav file format (16 bit mono) and 
contains all waveforms in series. A wavetable can consist of 1 to 256 
waveforms. Each single-cycle waveform is exactly 2048 samples long. 
A wav file containing a wavetable with 3 waveforms has a length of 3 x 2048 
samples. 

◦ Save Waveform – Saves the currently selected waveform to disc.

• ■ Init – The Init menu contains several initialization options.

◦ Create Wavetable: Saw Square Sine – 
Creates a three slot Wavetable that 
contains a Saw, Square and Sine wave.

◦ Create Wavetable: PWM – Creates a 
Wavetable using PulseWidth Modulated 
waves.

◦ Create Wavetable: Random – Creates a 
randomized Wavetable.

◦ Init Selection: Saw – Initialises the 
currently selected Wavetable slot to a Saw 
wave.

◦ Init Selection: Square – Initializes the currently selected Wavetable slot to a Square wave.

◦ Init Selection: Sine – Initializes the currently selected Wavetable slot to a Sine wave.

◦ Init Selection: Triangle – Initializes the currently selected Wavetable slot to a Triangle 
wave.

◦ Init Selection: White Noise – Initializes the currently selected Wavetable slot to a White 
Noise wave.

◦ Init Selection: Pink Noise – Initializes the currently selected Wavetable slot to a Pink Noise 
wave.

◦ Init Selection: Random Phase – Randomizes the Phase values for the currently selected 
Wavetable slot.

◦ Init Selection: Random Spectrum – Randomizes the Spectral values for the currently 
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selected Wavetable slot.
◦ Init Selection: Random Harmonic – Randomizes the Harmonic values for the currently 

selected Wavetable slot.

◦ Init Selection: Silence – Insert Silence into the currently selected Wavetable slot.

◦ Rename to MyWavetable – Rename the current wavetable name to MyWavetable.
  TIP  Save a wavetable with the file name of your choice and reload it to get a name 
of your choice. 

   
• ■ Undo / Redo – Use the Undo / Redo button to compare and undo changes that you made 

within the editor.

• ■ Copy – Copy the currently selected Wavetable slot.

• ■ Paste – Paste your copied slot to the currently selected Wavetable slot.

• ■ Cut – Cuts the currently selected Wavetable slot (note that you can still paste the cut out slot
back into a new slot)

• ■ Trim – Trims the Wavetable back to include only the selected waves. (if needed use the undo
button to undo this)

• ■ Sweep – The waveform currently selected by the blue box is picked and a morphing 
wavetable with many waveforms is created, replacing the old wavetable. You can find a 
detailed description of the different morph modes in the 'morph Modes menu' section of this 
handbook. The first slot of the sweep sounds like the MORPH knob set to 0, the last slot 
sounds like the MORPH knob set to 100.

  TIP  You can undo your changes with 'Tools->Undo/Redo Wavetable edit'.

  TIP  You can use this feature to create smooth filter sweeps and soft transitions for Morph 
modes which are 'steppy' like 'Bandpass 1oct'.
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• ■ Mix – The mix menu offers several mix functions, combined with a slider control to 
determine how much of the function is applied. Mouse-click on the Mix button to open the 
Mix menu and use the slider control to set the amount.

◦ Mix with copy – Mix the copied data with the selection 
(use the Copy button to first copy your data)

◦ Insert copy – Insert the copied data at the current 
selection point.

◦ Crossfade selection – Crossfades the selected data.

◦ Reverse selection – Reverses the selected data.

◦ Normalize volume – Normalizes the selected data's 
volume.

◦ Maximize volume – Applies a maximize process so 
waveforms with low volume are boosted

◦ Change volume to value – Changes the volume (Use the 
value slider control to set the amount)

◦ Stack Octave+ by value – Stacks an oscillator with another oscillator, one octave higher. 
(Use the value slider control to set the amount)

◦ Stack Octave- by value – Stacks an oscillator with another oscillator, octave higher and with
180 degree phase shifted. (Use the value slider control to set the amount)

◦ Stack Harmonic+ by value – Stacks an oscillator with another oscillator, two, three, four, 
five, six, seven or eight times higher. (Use the value slider control to set the amount)

◦ Stack Harmonic- by value – Stacks a 180 degree phase shifted oscillator with another 
oscillator, two, three, four, five, six, seven or eight times higher. (Use the value slider 
control to set the amount) This mode has a more hollow sound than 'Stack Harmonic+'

◦ Stack Power by value – Stacks several oscillators, two, three and four times higher. (Use 
the value slider control to set the amount)
  TIP  Use this mode together with sinoid waveforms to build organs.
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◦ Chord 2x by value – Two stacked oscillators play a chord. (Use the value slider control to 
set the amount)

◦ Chord 3x by value –Three stacked oscillators play a chord. (Use the value slider control to 
set the amount)

◦ PW by value – Applies Pulse-width Modulation. (Use the value slider control to set the 
amount)

◦ Comb 2x by value – Applies a comb filter with 2 stages. (Use the value slider control to set 
the amount)

◦ Comb 3x by value – Applies a comb filter with 3 stages. (Use the value slider control to set 
the amount)

◦ Half Wavetablesize size – skipped – Dumps half the wavetable, keeping only the first half.

◦ Half Wavetablesize size – interpolated – Dumps half the wavetable, interpolated.

◦ Fade out selection – Applies a fade out to the selected section.

◦ Fade in selection – Applies a fade in to the selected section.

• ■ Filter – The Filter menu offers several filter functions, combined with a slider control to 
determine how much of the function is applied. Mouse-click on the Filter button to open the 
Filter menu and use the slider control to set the amount.

◦ Tone warmer by value – Reduces the volume of high 
harmonics, making the selection sound warmer (Use 
the value slider control to set the amount)

◦ Tone brighter by value – Boosts the volume of high 
harmonics, making the selection sound brighter (Use 
the value slider control to set the amount)

◦ Denoise by value – Applies a Denoise process to the 
selection where noise is removed from the wavetable  

(Use the value slider control to set the amount)

◦ Lowpass by value – Applies a Lowpass filter to the selection (Use the value slider control to
set the amount)
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◦ Highpass by value – Applies a Highpass filter to the selection (Use the value slider control 
to set the amount)

◦ Bandpass 1oct by value – Applies a steppy spectral one octave bandwidth filter to the 
selection (Use the value slider control to set the amount)

◦ Bandpass 2oct by value – Applies a steppy spectral two octave bandwidth filter to the 
selection (Use the value slider control to set the amount)

◦ Bandstop 1oct by value – Applies a steppy spectral one octave bandstop filter to the 
selection (Use the value slider control to set the amount)

◦ Bandstop 2oct by value – Applies a steppy spectral two octave bandstop filter to the 
selection (Use the value slider control to set the amount)

• ■ Modify – The Modify menu offers several modifier functions, combined with a slider control
to determine how much of the function is applied. Mouse-click on the Modify button to 
open the Modify menu and use the slider control to set the amount.

◦ Saturate by value – Saturation is applied to the selected wave(s) (Use the value slider 
control to set the amount)

◦ Bitcrush by value – A bitcrush process is applied to the selected wave(s) (Use the value 
slider control to set the amount)

◦ Downsample by value – The selected wave(s) are downsampled (Use the value slider 
control to set the amount)

◦ Add Noise by value – Noise is applied to the selected wave(s) (Use the value slider control 
to set the amount)

◦ Ringmod by value – Ringmodulation is applied to the selected wave(s) (Use the value slider
control to set the amount)

◦ AM by value – Amplitude Modulation is applied to the selected wave(s) (Use the value 
slider control to set the amount)

◦ Sync Square by value – Applies hard sync to the selected wave(s) Useful for synced sounds 
and sharp sounding sweeps. (Use the value slider control to set the amount)
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◦ Sync Saw by value – Applies hard sync to the selected wave(s) Useful for speech synthesis, 
synced sounds and sweeps. (Use the value slider control to set the amount)

◦ Waveshape by value – Waveshaping is applied to the selected wave(s) (Use the value slider
control to set the amount)

◦ FM Sine by value – The selected wave(s) are FM modulated with a sine wave oscillator. 
(Use the value slider control to set the amount)

◦ FM Sine 2x by value – The selected wave(s) are FM modulated with a sine wave oscillator 
at double frequency. Which provides a hollow sound. (Use the value slider control to set 
the amount)

◦ FM Sine 3x by value – The selected wave(s) are FM modulated with a sine wave oscillator 
at triple frequency. Which provides a bell like sound. (use the value slider control to set the 
amount)

◦ FM Square by value – The selected wave(s) are FM modulated with a square wave 
oscillator. (use the value slider control to set the amount)

◦ FM Saw by value – The selected wave(s) are FM modulated with a saw wave oscillator. (use
the value slider control to set the amount)

◦ Harmonic by value – Applies a partial morph with smooth transitions. (use the value slider 
control to set the amount)

◦ Hollow1-3 by value – Applies a partial morph with smooth transitions and hollow sound. 
(use the value slider control to set the amount)

◦ Hollow Double by value – Applies a partial morph at double frequency, with smooth 
transitions and hollow sound. (use the value slider control to set the amount)

◦ PhaseDist PW by value – Applies Phase Distortion with pulsewidth control to the selected 
wave(s) (Use the value slider control to set the amount)

◦ PhaseDist Saw by value – Applies Phase Distortion to the selected wave(s) Morphing a sine
wave to a sawtooth. (Use the value slider control to set the amount)

◦ PhaseDist Square by value – Applies Phase Distortion to the selected wave(s) Morphing a 
sine wave to a square. (Use the value slider control to set the amount)

◦ PhaseDist Double by value – Applies Phase Distortion to the selected wave(s) Morphing 
the wave to a wave with double frequency. (Use the value slider control to set the amount)
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◦ Mirror by value – Mirrors the waveform(s) in the middle. (Use the value slider control to 
set the amount)

◦ Grunge by value – Adds additional harmonics to the selected wave(s). (Use the value slider
control to set the amount)

• ■ Spectrum – The Spectrum menu offers several spectrum edit functions, combined with a 
slider control to determine how much of the function is applied. Mouse-click on the Spectrum 
button to open the Spectrum menu and use the slider control to set the amount.

◦ Clean by value (bright sound) – Cleans the selected 
wave's spectrum. The resulting wave(s) usually 
sounds more 'bright'. (Use the value slider control to
set the amount)

◦ Clean by value (warm sound)  – Cleans the selected 
wave's spectrum. The resulting wave(s) usually 
sounds more 'warm'. (Use the value slider control to 
set the amount)

◦ Enhance by value – Enhances the selected wave's 
spectrum. The resulting wave(s) usually have more 
'character'. (Use the value slider control to set the 
amount)

◦ Square harmonics – Every second harmonic is set to 0. It gives a hollow sound. A sawtooth 
is turned into a square wave.

◦ N harmonics by value – All harmonics except every Nth one are set to 0. Value defines the 
gap distance. It gives a hollow, bell-style sound. (Use the value slider control to set the 
amount)

◦ Organ harmonics by value – All harmonics except the power of  N^M are set to 0. Value 
defines the gap distance. It gives an organ-style sound. (Use the value slider control to set 
the amount)

◦ Bell harmonics by value – All harmonics except the power of  N are set to 0. Value defines 
the gap distance. It gives a bell-style sound. (Use the value slider control to set the amount)

◦ Shift up – All harmonic are moved upwards. It results in a bright sound one octave higher.

◦ Shift down – All harmonic are moved downwards. It results in a darker sound.
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◦ Stretch – All harmonics are duplicated and the spectrum is stretched. It results in a brighter
sound.

◦ Shrink – Every second harmonic is removed and the spectrum is shrinked. It results in a 
darker sound.

◦ Interval by value – Creates a harmonic interval. With a value set to 0 it will play the base 
frequency. Higher values result in a frequency 2,3,4,5,6,7 or 8 times higher. (Use the value
slider control to set the amount)

◦ Sort by brightness – Sorts waveforms by their harmonic content. It can be used to create 
wobbles

• ■ Phase – The Phase menu offers several phase edit functions, combined with a slider control 
to determine how much of the function is applied. Mouse-click on the Phase button to open 
the Phase menu and use the slider control to set the amount.

◦ Set to 0 – Sets the selection's phase to zero.

◦ Set to value – Sets the phase(s) to a specific value. 
(use the value slider control to set the amount)

◦ Invert – Inverts the selection's phase.

◦ Silky Static – Modifies the selection's phase to 
sound more silky.

◦ Silky Add – Modifies the selection's phase to sound more silky.

◦ Noisy by value– Modifies the selection's phase to sound more noisy.

◦ Sweep by value – Applies a phase sweep to the selection. (use the value slider control to 
set the amount)

◦ Reverse – Reverses the selection's phase.

◦ Optimize phases to reduce rumble – When you morph through a wavetable with the 
WAVE knob you sometimes hear some rumbling or detuning. The Optimize phases.... 
option reduces rumbling and detuning
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• ■ Resynthesis – Resynthesizes and creates a wavetable from an imported sample.

◦ Resynthesis smart pitch snap – Resynthesize using 
Smart pitch snap enhances the sound quality. 
Select a wav file and it automatically creates a 
synthesizer patch which syncs to BPM.

◦ Resynthesis  – Resynthesize uses the default mode, 
which gives the best results for most sounds.

◦ Resynthesis Additive – Works like the default 
Resynthesis, but removes all phase information and 
detuning from the sample. As a result you get the 
cold sound known from additive synthesizers. 

◦ Resynthesis for Noisy sounds – Works like the normal resynthesis, but sometimes gives 
better results with very noisy sounds like flutes.

◦ Resynthesis Note=C4 – Resynthesize from a sample tuned to C4.

◦ Resynthesis Note=C3 – Resynthesize from a sample tuned to C3 

◦ Resynthesis Note=C2 – Resynthesize from a sample tuned to C2 

◦ Resynthesis Note=C1 – Resynthesize from a sample tuned to C1 

◦ Resynthesis Note=C0 – Resynthesize from a sample tuned to C0 

◦ Granular – Creates a wavetable using granular synthesis. In granular synthesis a sample is 
divided into small 'grains' with a window function. 

• ■ Vocoder – Creates a Vocoder Wavetable using an imported sample.

◦ Vocoder Saw – Creates a Vocoder Wavetable using a Saw wave 
carrier.

◦ Vocoder Square – Creates a Vocoder Wavetable using a Square 
wave carrier.

◦ Vocoder Silky – Creates a Silky Vocoder Wavetable.
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◦ Vocoder Noise – Creates a Vocoder Wavetable using a Noise wave carrier.
■ Editor / Display Mode

The Editor / Display mode buttons allow you to switch between these editor modes.

◦ Exit – Exits the Wavetable editor and switches back to the synthesizer.

◦ Waveform – Switches the editor to Waveform mode. Inside Waveform mode you can edit 
the raw waveshape. A complete set of draw tools are provided (bottom left of the wave 
display) to help you edit your waveform, a description of these tools is found in the 
Wave/Spectrum/Phase display section.

◦ Spectrum – Switches the editor to Spectrum mode. Inside the spectrum mode you can 
change the amplitude of each partial.

◦ Phase – Switches the editor to Phase mode. Inside Phase mode you can directly edit the 
phase spectrum, which can add breathiness, detune harmonics or help make organic 
timbres. 

■ Wave / Spectrum / Phase Display

The Wave / Spectrum / Phase Display section allows you to directly edit, as well as provide you with a 
visual display of, the current waveform(s)
The type of editor display is switchable by either clicking on the Waveform, Spectrum or Phase button.
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In Waveform mode an additional Toolbar with draw tools is provided to help you further edit your 
waveform.
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■ Filter

Icarus’ filter section has two identical filters, each with an excellent range of filter types to sculpt your 
sound. These filter types range from traditional analog Low Pass, High Pass, Notch and Band pass 
filters, up to digital ones like Vocal, Phaser, Ringmod, Comb and Fractal filters. A large number of these
filter types are exclusive to Tone2 and not available in any other product.

Filter types are selected by clicking on the filter name label, a menu will open from where you can 
select one of the 62 filter types.

The filters can either be routed in parallel or in series. When routed in parallel the output from each 
filter is independently sent to the next stage in the audio chain (the Insert Effect). 

In serial mode, the output of Filter 1 is sent to the input of Filter 2. To switch between parallel / series 
mode, click the Parallel button found at the bottom of the filter section. When the button is in the ‘on’
position the filters are in parallel, in the off position the filters are in series.
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■ Filter menu

• Filter < > – Use these arrows to easily step navigate through the available filters. (note that this
function is only available for filter 1)

• OSC 1 – Routes Oscillator 1’s output to this filter.

• OSC 2 – Routes Oscillator 2’s output this filter.

• OSC 3 – Routes Oscillator 3’s output this filter.

• ON – Switches the filter on / off.

• Filter Reset / Copy menu – Click on the Filter label to show a menu with filter Reset and Copy 
options. Reset will reset a filter to its default filter settings (12dB Digital LP) Copy will copy all 
current settings from one filter to the other filter.

■ Filter display

The filter display displays the real time shaping of the filter as you alter the Cutoff and Resonance 
parameters. The horizontal axis show frequencies from lowest to highest, while the vertical axis 
represents the gain. This gives you immediate visual feedback on your actions. Click on the filter 
name to select a filter type from the context menu.
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Click on the filter name to select a filter type.

Here you have a selection of both classic analog-style as well as digital filters in low pass, band pass 
and high pass variations, with multiple slopes – 12dB, 18dB and 24dB.
In addition to the analog filters, various EQ filters are available as well as the more unusual filter types 
such as the Phaser, Combs, Vocal filter, etc.

Icarus also features a range of exotic filter types, like Vocal, Phaser, Resample, Ringmod, FM and 
Fractal filters. Four special Resonator filter types to be used for Physical Modeling purposes are also 
featured (Phys String, Phys Flute, Phys Odd & Phys Even) 
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■ Filter controls

• CUTOFF – The Cutoff control knob changes the frequency at which the filter character changes
relative to the filter type. 

• RESO – The Reso (resonance) control knob increasingly alters the characteristic of the filter 
the more this value is increased. In traditional analog-style filters (low pass, high pass and 
band pass filters), the resonance control makes the cut off point more pronounced by 
increasing the volume of the Cutoff frequency. 

• KEY – The key knob is a bi-polar control that determines how the note played on the keyboard
affects the filter cut off frequency. At positive values above 0, higher note values will increase 
the cut off frequency. At negative values below 0, higher note values will decrease the cut off 
frequency.

• FILT ENV – The filter envelope control knob determines how much influence the filter 
envelope has on the Cutoff control and in which direction. Positive values over 0 will increase 
the filter cut off value as the envelope outputs a positive value. Negative values under 0 will 
decrease the cut off value as the envelope outputs a positive value.

• ENV VEL – The velocity control knob determines how much of the filter envelope is applied 
based on its velocity value.

• VEL – The cutoff velocity control determines how much influence velocity has on the cutoff  
control. Positive values over 0 will increase the filter cut off value, negative values under 0 will 
decrease the cut off value.

• LFO3 – LFO3 is a hardcoded modulation control which controls how much of LFO3's 
modulation should be applied to the cutoff control.

• VOL – Volume control.
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• DRIVE – The drive control knob increases the amount of extra gain to the oscillator audio 
signal before it enters the filters. This can drastically change the characteristics of the filter. 
There are different drive 'models' that can be selected in the filter display:

◦ Distortion off – No drive is applied.

◦ Saturate – A distortion with very soft saturation. It has a warm and analog sound.

◦ Soft Clip – A distortion with soft clipping. It has a warm and analog sound.

◦ Hard Clip – A distortion with aggressive, hard clipping. It has a bright sound.

◦ Rectify – Rectify hard-clips the signal and mixes the processed signal back in with the 
original sound.

◦ Bitcrush – This is a bitcrusher effect which is modeled after old digital equipment with a 
low bit rate. Think of the early digital samplers with 8-bit sound. 

◦ Warp – A distortion that sounds like a guitar amp.

◦ Waveshape – A waveshaper which adds an FM-type timbre to the audio. 

◦ Ripple – A waveshaper which adds ripple to the signal. It has bright sound.

◦ Volume – Changes the volume of the filter output. This mode is useful to control the 
balance, if you use two filters routed in parallel.
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  TIP  Remember that as you increase the Env control you’ll probably need to turn down the Cutoff 
otherwise you won’t hear much of the envelope affecting the cut off. However, you’ll need to increase 
the Cutoff if you want to use negative Env amounts

  TIP   About the basic filter types 

In a Low Pass Filter (LPF), the Cutoff control will set the frequency at which the filter begins to ‘close’ 
and allow less and less of the higher frequencies through. When the frequencies are high enough past 
the cut off point, no more sound will be allowed through the filter.

A High Pass Filter (HPF) allows high frequencies to be heard, but blocks the lower frequencies. It is 
frequently used to create hi-pitched whistle sounds, and piercing synthesizer leads.

A Band Pass Filter (BPF) allows the frequencies within a specific range to be heard, and blocks out all 
the other frequencies above and below it. It can be used to create a variety of effects, from the subtle 
to insane! Also, the filter’s slope is important. Basically, slope is the amount of attenuation at certain 
frequencies. We usually discuss slope in terms of decibels per octave. 

The lower the dB per octave, the more ‘gentle’ the filter sounds. e.g. a 12dB per octave filter will 
remove 12dB of harmonics per octave above the filter cut off frequency.
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■ Envelopes

The envelope section has four envelopes which can be used to modify many of Icarus’ parameters. 
Two of the envelopes are ‘hard-wired’; the Volume Envelope is fixed to control the Amplifier and the 
Filter Envelope controls the Filter, both auxiliary envelopes can be freely assigned using the 
Modulation Matrix. 

Both the Volume and Filter Envelope are displayed by default, inside the Filter Env. Section you’ll find 
two tabs (Aux1 & Aux2) to switch to the auxiliary envelopes.

The envelope section has a dynamic display that shows the shape of the selected envelope. Click 
inside this display to open a list of preset envelope shapes or to reset the envelope to its default 
settings.

The following controls are used for the envelopes:

• Retrig – Switches the envelope trigger mode to normal or special.
• A – This controls the attack time of the envelope.
• H – This specifies the hold time of the envelope.  
• D – This controls the decay time of the envelope. 
• S – This sets the level of the sustain section. 
• R – This sets the release time of the envelope.
• SHAPE – This specifies the shape of the envelope curves. The values are from 0 which is a 

linear curve or pure straight line, up to 9 which is a logarithmic curve or a curved line.

Note: within each Envelope section (top of the ENV) you’ll see a cross shaped icon, this is used for 
assigning drag & drop modulation, more about this can be found inside of the Modulation Matrix 
chapter.

  TIP  Click inside the Envelope display to open a list of pre-set envelope shapes or to reset the envelope
to its default settings.
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  TIP   What is an envelope An envelope generator allows a synthesizer to mimic acoustic instruments’ 
properties of changing volume and timbre over time. Traditionally, an envelope generator produced a 
control voltage that varied over time which could be used to automatically change the filter cut off or 
amplifier volume. There are many different types of envelopes but the most common one is known as 
an ADSR which is an acronym for Attack, Decay, Sustain and Release which describes the four controls 
of the envelope. Another variant is the AHDSR which is an acronym for Attack, Hold, Decay, Sustain 
and Release. The AHDSR is used in Icarus. 

A description of these are as follows.

Attack – Is a time value which states how long it takes for the envelope to go from zero to maximum 
peak when a key is pressed.

Hold – Is a time value which states how long it takes for the envelope to wait at maximum peak value.

Decay – is a time value which states how long it takes for the envelope to drop to the sustain level.

Sustain – Is a level value which states the highest value while the key is being held down after the 
Attack, Hold and Decay stages.

Release – Is a time value which states how long it takes for the the envelope to drop back down to 
zero after the key has been released
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■ MSEGs

The Multiple Segment Envelope Generators (MSEG) provide more complex modulation envelopes, a 
graphical representation of the envelope generator output allows for precise adjustment of the 
envelope and its parameters. 

The envelope appears as a grid with series of points joint by lines / curves representing the different 
stages of the envelope, each of its points with independent time, level, and slope values.
Any number of points can be add in to the envelope and the segments linking these points 
can be linear or curved. With a variety of sync and snap-to functions it is easy to use the MSEGs to 
create complicated rhythmic patterns.

■ How to use the editor
Creating and editing the envelopes is done by adding, moving, removing points and adjusting curves 
of the envelope sections between each point.
Please note that points are displayed using a small square icon, sections are displayed using a small 
circle.

Creating new points: new points are created by double-clicking anywhere within the envelope, once a 
point is created it is represented by a small square. Note that each time a new point is created a 
section between 2 points will also be created (represented by a small circle)

Deleting points: double-click on an existing point to delete it.

Moving points: move a point by highlighting the point you want to edit (a small circle will appear 
around the point) left-click and drag-move the point to its new destination.
Bending section: bend a section by highlighting the section you want to edit (a small circle will appear 
around the section handle) left-click and drag-move the section to bend its curve.
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Bend all sections up / down: hold Alt+left mouse to click on a section and bend all sections at once.

Draw rectangles: use Shift+left mouse to draw square shapes, note that the size of the square shapes 
is determined by the Grid X setting, the higher its value the smaller the square drawn.

Move points on Grid: use Alt+left mouse to move a point along the locked Y axis. Note that if a point is
off grid Alt+left mouse will first snap move the point to its nearest Y grid axis.

Using the Loop option the MSEG can be looped between any two points, i.e. once you play hold a key, 
the envelope will keep repeating the looped stages until you release the key. 
Use the Loop dial to set your loop point (represented by a ‘loop’ label inside of the envelope display)
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■ MSEG Controls

• BPM sync – Switches on the BPM sync mode for the envelope, in BPM mode the speed range 
will be displayed in multiples of the host tempo (e.g. ½ is half of your host’s speed) In non BPM
mode range will be shown in Hertz (Hz)

• Start – Adjusts the position from which the envelope should start.

• Loop – Adjusts the looping point for the envelope.

• Rise off – Adds a fade-in.

• Delay – Sets the amount of time the envelope is delayed once a note is played.

• Grid X – Adjusts the X axis grid size.

• Grid Y – Adjusts the Y axis grid size.

• Free – In Free mode single points are created by clicking anywhere within the envelope.

• Bar – In Bar mode square shapes are created by click-hold dragging the left mouse button 
anywhere within the grid.

• SnapX – Snap to the Grid’s X axis 

• SnapY – Snap to the Grid’s Y axis 

• Down – Draws / edits the segment(s) to a downward curve.
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• Up – Draws / edits the segment(s) to an upward curve.
<Preset>

The Presets menu offers several envelope related load / save / reset options. 

◦ Load – Loads an envelope template from disk.

◦ Save – Saves an envelope template to disk.

◦ Reset – Resets the envelope to its default settings.

Note: Once saved to disk your own saved MSEG presets will show up inside this menu. MSEG presets 
are saved to ’\Icarus_data\Icarus_mseg\’
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■ LFOs

LFO is an acronym for Low Frequency Oscillator. LFOs are oscillators that operate below the threshold 
of human hearing (20 Hertz). They are used as modulators and are assigned in the Mod Matrix.

Icarus has three identical LFOs and a Step LFO. The waveform display shows a visual representation of 
the waveform. The Step LFO looks slightly different and will be explained separately.

Choosing a shape for your LFO is easy, right-click inside of the LFO display and a list with predefined 
shapes will open.

After selecting a shape it can be further edited using the shape and phase knobs.

• LFO 1,2,3 tabs – The tabs select which one of the three LFOs is displayed for editing. 

• SPEED – This knob controls the speed of the LFO. The range depends on the Mode: 
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◦ In BPM Mode – The range will be shown as a multiple of the host's tempo. e.g. 1/2 BPM is 
half of your host's tempo, 4 BPM is four times your host's tempo.

◦ In non-BPM Mode – The range will be shown in Hertz (Hz). The range is 0.02 Hz to 440.1 Hz

• TRIG – Trigger mode, which will restart its cycle with every new note that is played.

• ENV  – Switches the One Shot envelope Mode On / Off.

• Shape – Adjusts the current shape.

• Key – Sets the amount of key follow to use. 

• Phase –  This will adjust the starting position of the waveform.

• Fade in – This control adds a fade-in.
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■ Step LFO

The Step LFO uses a Multi-Stage Envelope in which you can set up your own shape by dragging 
envelope points. Simply left or right-click on one of its points and drag it to the desired location.

Like LFOs, a step LFO doesn’t produce any sound in itself, a step LFO is used to modulate another 
sound parameter to achieve cyclic modulations (changes) of this parameter over time, according to 
the Speed knob settings.

Please note that the step LFO is always synced to your host’s tempo.

Available controls are:

• SPEED – This knob controls the speed of the StepLFO. The range depends on the Mode: 

◦ In BPM Mode – The range will be shown as a multiple of the host's tempo. e.g. 1/2 BPM is 
half of your host's tempo, 4 BPM is four times your host's tempo.

◦ In non-BPM Mode – The range will be shown in Hertz (Hz). The range is 0.02 Hz to 440.1 Hz

• TRIG – Trigger mode, which will restart its cycle with every new note that is played.

• ENV  – Switches the One Shot envelope Mode On / Off.

• Smooth – Smooths the steps’ shape.

• Key – Sets the amount of key follow to use. 

• Phase –  This will adjust the starting position of the waveform.

• Fade in – This control adds a fade-in.

Note: within each LFO section (top of the LFO) you’ll see a cross shaped icon, this is used for assigning 
drag & drop modulation, more about this can be found inside of the Modulation Matrix chapter.
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■ Modulation Matrix

The Modulation Matrix (Mod. Matrix) allows you to assign modulators such as LFOs or envelopes to 
different destinations (such as the filter, amplifier or even other modulators). 
Icarus’ modulation system supports drag & drop for assigning matrix entries, which works like this:

• Left mouse click-hold the cross icon found inside one of the modulator sections, you’ll see a 
red line appear.

• Drag this line to the target you want to assign the modulator to, the line should now turn from 
red to green.

• Let go of the mouse button and your modulation is created, the Modulation Matrix will open 
to display your new modulation.

Left mouse click-hold and drag the red line to your preferred target, the line will turn 
green, let go of the mouse button and your modulation is assigned.

The Modulation Matrix now displays your newly created modulation.
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After assigning modulation to a control the modulation amount / range will be displayed in a lighter 
color within the knob (clipping will be shown in red)
Should you want remove its modulation; right-click on a control and click on "remove modulation" to 
remove it.
Hovering the mouse over a knob will show its current parameter value and modulation source.

Modulation can also be assigned by right-clicking on knobs and choosing your modulation path from 
its context menu. From within this menu it’s also possible to Reset Values or midi-learn controllers.

◦ Reset to default value – This resets the control to its default value

◦ Reset all (value, modulation, midi) – This resets the control to its default value, clears any 
modulation assigned to it as well as removes any midi CC assigns to this control.

◦ Midi learn → assign CC – Activates Midi learn for this control.

◦ Modulation menus – These menus contain all modulation destination options.

◦ Remove modulation – This will remove all modulation tied to this control.
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■ Matrix

The modulation Matrix has 18 slots you can use to make 18 modulation assignments. The procedure 
for assigning modulation is very simple:

1. Click on the left side of a modulation slot and pick a modulator (modulation source) from the 
drop-down menu. This modulator is what will cause the modulation or changing effect. 

2. Click on the right side of the modulation and choose a target (destination) from the drop-
down menu. This is what gets affected by the modulation or changing effect. 

3. Drag the modulation amount control to increase / decrease the modulation amount value. 
This is how much modulation gets sent to the destination. The lower the value the more 
subtle the effect. 

If needed the modulation matrix can easily be reinitialized by using the Init menu found in Icarus’ 
main section. Simply click on the Init button and choose “init Matrix” from its menu, 
this will reset all modulation matrix controls to their original off settings.
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■ Modulation Source menu

If you left-click on one of the modulation source areas on the Matrix display, the modulation sources 
menu appears. 

◦ Off – No modulation source selected. This is the default selection. 

◦ Fixed – This option uses a static fixed value as the modulation source. The value is taken 
from the Modulation Amount parameter. This option is useful if you need a parameter 
offset to any modulation destination.

■ LFO

◦ LFO1+ – LFO1 in unipolar mode, only uses LFO1's positive values.

◦ LFO1+- – LFO1 in bipolar mode, this uses LFO1's negative and positive values.

◦ LFO2+ – LFO1 in unipolar mode, only uses LFO1's positive values.

◦ LFO2+- – LFO2 in bipolar mode, this uses LFO1's negative and positive values.

◦ LFO3+ – LFO1 in unipolar mode, only uses LFO1's positive values.

◦ LFO3+- – LFO2 in bipolar mode, this uses LFO1's negative and positive values.

◦ Step+ – Uses the Step LFO in unipolar mode using only positive values. 

◦ Step+- – Uses the Step LFO in bipolar mode using both positive and negative values. 
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■ Free running LFO 

◦ Sine1/64Hz – Sine16Hz – Uses a sine shape as modulation source, the amount of Hz 
denotes the modulation speed used.

■ Envelope

◦ Vol Env – This selects the Volume Envelope as the modulation source. Although the Vol Env
is hard-wired to the amplifier, it can also be used to modulate another destination at the 
same time.

◦ Filt Env – This selects the Filter Envelope as the modulation source. Although the Filt Env is 
hard-wired to the Filter, it can also be used to modulate another destination at the same 
time. 

◦ Aux1 Env – This selects the Auxiliary 1 Envelope as the modulation source. Unlike the Vol 
Env and the Filt Env the Auxiliary Envelopes are not hard-wired to anything so they must be
routed in the Mod Matrix for their effect to be heard.

◦ Aux2 Env – This selects the Auxiliary 2 Envelope as the modulation source. 

◦ Key Pressed – Applies an On / Off Gate modulation; i.e. on key press its value is 1, on 
release it's 0.
 

◦ Key Pressed- – Applies an Off / On Gate modulation; i.e. on key press its value is 0, on 
release its 1.

◦ Decay8ms-16s – Decay will use an internal envelope to modulate, available are envelopes 
that run from 4 milliseconds to 16 seconds, as well as an impulse for very short modulation
tasks, such as a very snappy or sharp attack sound.

■ MSEG

◦ MSEG1 + – This selects Multiple Segment Envelope Generator 1 as the modulation source, 
in unipolar mode using only its positive values.

◦ MSEG1 +- – This selects Multiple Segment Envelope Generator 1 as the modulation source,
in bipolar mode using both negative and positive values.

◦ MSEG2 + – This selects Multiple Segment Envelope Generator 2 as the modulation source, 
in unipolar mode only using its positive values.
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◦ MSEG2 +- – This selects Multiple Segment Envelope Generator 2 in bipolar mode.
■ Velocity

◦ Velocity+ – Uses the positive Velocity values to modulate

◦ Velocity+ - – Uses both the positive and negative Velocity values to modulate.

◦ Arp Vel+ – Applies the arpeggiator’s velocity steps as modulation source using only positive
values. 

◦ Arp Vel+- – Applies the arpeggiator’s velocity steps as modulation source using both 
positive and negative values.

■ Key

◦ Key – This will use the note value of the key you play on your keyboard controller as a 
modulation source. A low note will generate a low number, a high note will generate a high
number. 

◦ Key split high – Assigns the high keys of a keysplit to be used as modulation source.

◦ Key split low – Assigns the low keys of a keysplit to be used as modulation source.

◦ Key C C# D….–  Key C C# D….–  Every C-key will return 0 as source value, a C# key will return
1/12, D will return 2/12, B will return 11/12….

◦ Key Octave  – Similar to Key C C# D…, but with octaves.

■ Midi

◦ Modwhl./Macro – This will use the modulation wheel from your keyboard controller or 
Macro knob on Icarus’ GUI as a modulation source.
Note that you will only change the value if you move the modwheel / Macro knob, 
otherwise the value will be static (which will be the last value transmitted by the 
modwheel / macro control).

◦ Pitchwheel – This will use the pitchwheel from your keyboard controller as a modulation 
source. 

◦ Aftertouch – This will use the channel aftertouch messages from your keyboard controller 
as a modulation source. Please check the operating instructions of your keyboard 
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controller to see if it generates aftertouch information. Not all keyboard controllers do. 

◦ Breath – Responds to Breath controller as modulation.
◦ Foot – Responds to Foot switch controller as modulation source.

◦ MainVol – Responds to Main Volume controller (CC#7) as modulation source

◦ Expression – Responds to Expression controller (CC#11) as modulation source.

◦ Hold – Responds to Hold pedal (sustain) On/Off (CC#69) as modulation source.

◦ Poly Aftertouch – This will use the polyphonic aftertouch messages from your keyboard 
controller as a modulation source. Please check the operating instructions of your 
keyboard controller to see if it generates polyphonic aftertouch information. Not all 
keyboard controllers do. 

◦ CC16 - CC19 – Responds to CC#16 to CC#19 (continuous controllers) as modulation source.

■ Random
 

◦ Random – This option selects a new random value when a key is pressed on your keyboard 
controller. Note that the value will be static until you play a new note when a new random 
value will be created. 

◦ Flipflop +-  – This option 'flips' between two values. The value is determined by the 
Modulation Amount. e.g. a Modulation Amount of 10 would 'flip' between  +10 and -10. 
However, the parameter that is going to be modulated acts as a value offset.

◦ White Noise – This option generates white noise. This is a continuously varying random 
value. 

◦ Pink Noise – This option generates pink noise. This is a continuously varying random value. 

■ Function(X)

◦ X*X – Uses the X multiplied by X value modifier as modulation source.

◦ Sqrt (X) – Uses Squareroot X value modifier as modulation source.
Filter

◦ Filter (X) – Uses the filter X value modifier as modulation source.
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◦ Limit (X) – Uses the Limit X value modifier as modulation source.

      
■ Modulation Destination menu

If you left-click on one of the destination areas on the Matrix display, the modulation destination 
menu appears. 

The menu options are.

◦ Off  - No modulation destination selected. This is the default selection. 

◦ Volume – The volume of the current layer. 

◦ Pan – Selects the Master Panning control .

■ Osc1-3

◦ Octave – Selects the Master Octave (Osc1, OSC2, OSC3)

◦ Semi – Selects the Master Semitone setting.

◦ Pitch XL – Selects the Master Pitch XL.

◦ Pitch –  Selects the Master Pitch.

◦ Fine – Selects the Master Fine control.

■ Osc1

◦ Wave 1 – Selects the Wave setting of Oscillator 1.

◦ Morph 1 – Selects the Morph setting of Oscillator 1.

◦ Volume 1 – Selects the Volume setting of Oscillator 1.

◦ Pan 1 – Selects the Pan setting of Oscillator 1.

◦ Octave 1 – Selects the Octave setting of Oscillator 1.

◦ Interval 1 – Selects Oscillator 1’s Interval, shifting the base frequency of the oscillator. The 
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modulation slider selects the harmonic relationship (1x-16x). Useful for building custom 
chords.

◦ Semi 1 – Selects the Semitone setting of Oscillator 1. 

◦ Pitch XL 1 – Selects the Pitch XL control setting of Oscillator 1. 

◦ Pitch 1 – Selects the Pitch control setting of Oscillator 1. 

◦ Fine 1 – Selects the Fine Tune setting of Oscillator 1. 

◦ Detune 1 – Selects the Detune setting of Oscillator 1. 

■ Osc2

◦ Wave 2 – Selects the Wave setting of Oscillator 2.

◦ Morph 2 – Selects the Morph setting of Oscillator 2.

◦ Volume 2 – Selects the Volume setting of Oscillator 2.

◦ Pan 2 – Selects the Pan setting of Oscillator 2.

◦ Octave 2 – Selects the Octave setting of Oscillator 2.

◦ Interval 2 – Selects Oscillator 2’s Interval, shifting the base frequency of the oscillator. The 
modulation slider selects the harmonic relationship (1x-16x). Useful for building custom 
chords.

◦ Semi 2 – Selects the Semitone setting of Oscillator 2. 

◦ Pitch XL 2 – Selects the Pitch XL control setting of Oscillator 2. 

◦ Pitch 2 – Selects the Pitch control setting of Oscillator 2. 

◦ Fine 2 – Selects the Fine Tune setting of Oscillator 2. 

◦ Detune 2 – Selects the Detune setting of Oscillator 2. 

■ Osc3

◦ Wave 3 – Selects the Wave setting of Oscillator 3.
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◦ Morph 3 – Selects the Morph setting of Oscillator 3.

◦ Volume 3 – Selects the Volume setting of Oscillator 3.

◦ Pan 3 – Selects the Pan setting of Oscillator 3.
◦ Octave 3 – Selects the Octave setting of Oscillator 3.

◦ Interval 3 – Selects Oscillator 3’s Interval, shifting the base frequency of the oscillator. The 
modulation slider selects the harmonic relationship (1x-16x). Useful for building custom 
chords. 

◦ Semi 3 – Selects the Semitone setting of Oscillator 3. 

◦ Pitch XL 3 – Selects the Pitch XL control setting of Oscillator 3. 

◦ Pitch 3 – Selects the Pitch control setting of Oscillator 3. 

◦ Fine 3 – Selects the Fine Tune setting of Oscillator 3. 

◦ Detune 3 – Selects the Detune setting of Oscillator 3.

■ Filter1
  

◦ Cutoff 1 – Selects the Filter Cut Off setting of Filter 1.

◦ Reso 1 – Selects the Filter Resonance setting of Filter 1.

◦ Drive 1 – Selects the Filter Drive setting of Filter 1.

◦ Filter1 Env – Selects the Filter 1 Envelope setting.

◦ Filter Balance – Selects the Filter Balance setting, this lets you to control the balance 
between filter 1 & filter 2.

■ Filter2
  

◦ Cutoff 2 – Selects the Filter Cut Off setting of Filter 2.

◦ Reso 2 – Selects the Filter Resonance setting of Filter 2.

◦ Drive 2 – Selects the Filter Drive setting of Filter 2.
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◦ Filter2 Env – Selects the Filter 2 Envelope setting.

■ LFO1

◦ LFO1 Speed – Selects the Speed setting of LFO 1.

◦ LFO1 Phase – Selects the Phase setting of LFO 1.
■ LFO2

◦ LFO2 Speed – Selects the Speed setting of LFO 2.

◦ LFO2 Speed – Selects the Phase  setting of LFO 2.

■ LFO3

◦ LFO3 Speed – Selects the Speed setting of LFO 3.

◦ LFO3 Speed – Selects the Phase  setting of LFO 3.

■ Step

◦ Step Phase – Selects the Phase setting of the Step LFO.

◦ Step Speed – Selects the Speed setting of the Step LFO.

■ Volume Env

◦ Vol A – Selects the Volume Envelope's Attack control.

◦ Vol H – Selects the Volume Envelope's Hold control.

◦ Vol D – Selects the Volume Envelope's Decay control.

◦ Vol S – Selects the Volume Envelope's Sustain control.

◦ Vol R – Selects the Volume Envelope's Release control.

■ Filter Env

◦ Filter A – Selects the Filter Envelope's Attack control.
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◦ Filter H – Selects the Filter Envelope's Hold control.

◦ Filter D – Selects the Filter Envelope's Decay control.

◦ Filter S – Selects the Filter Envelope's Sustain control.

◦ Filter R – Selects the Filter Envelope's Release control.

■ Aux1 Env

◦ Aux1 A – Selects the Aux1 Envelope's Attack control.

◦ Aux1 H – Selects the Aux1 Envelope's Hold control.

◦ Aux1 D – Selects the Aux1 Envelope's Decay control.

◦ Aux1 S – Selects the Aux1 Envelope's Sustain control.

◦ Aux1 R – Selects the Aux1 Envelope's Release control.

■ Aux2 Env

◦ Aux2 A – Selects the Aux2 Envelope's Attack control.

◦ Aux2 H – Selects the Aux2 Envelope's Hold control.

◦ Aux2 D – Selects the Aux2 Envelope's Decay control.

◦ Aux2 S – Selects the Aux2 Envelope's Sustain control.

◦ Aux2 R – Selects the Aux2 Envelope's Release control.

■ Matrix Send

◦ Matrix 1-18 – Selects the Modulation Amount setting of Modulation Matrix slot 1-18 

■ EQ

◦ EQ low – Selects the Equalizer low control setting. 

◦ EQ high – Selects the Equalizer high control setting. 
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◦ EQ mid – Selects the Equalizer mid control setting. 

◦ EQ mid Freq – Selects the Equalizer mid Freq control setting. 

◦ EQ mid Q – Selects the Equalizer mid Q control setting. 

■ FX

◦ Fx1 Mix –  Selects the FX1 Mix control as destination.

◦ Fx1 Par1 –  Selects the FX1 Parameter 1 control as destination.

◦ Fx1 Par2 –  Selects the FX1 Parameter 2 control as destination.

◦ Fx1 Par3 –  Selects the FX1 Parameter 3 control as destination.

◦ Fx1 Par4 –  Selects the FX1 Parameter 4 control as destination.

◦ Fx2 Mix –  Selects the FX2 Mix control as destination.

◦ Fx2 Par1 –  Selects the FX2 Parameter 1 control as destination.

◦ Fx2 Par2 –  Selects the FX2 Parameter 2 control as destination.

◦ Fx2 Par3 –  Selects the FX2 Parameter 3 control as destination.

◦ Fx2 Par4 –  Selects the FX2 Parameter 4 control as destination.

◦ Fx3 Mix –  Selects the FX3 Mix control as destination.

◦ Fx3 Par1 –  Selects the FX3 Parameter 1 control as destination.

◦ Fx3 Par2 –  Selects the FX3 Parameter 2 control as destination.

◦ Fx3 Par3 –  Selects the FX3 Parameter 3 control as destination.

◦ Fx3 Par4 –  Selects the FX3 Parameter 4 control as destination.

ICARUS 3 Manual - 88 -



◦ Feedback –  Selects the Feedback control as destination.

◦ Effect Mix –  Selects the Effect Mix control as destination.

X:=Value – Selects the X:=Value destination.

■ Modulation Matrix: value modifiers (X:=Value)

Icarus gives you the option to use a modifier on the source value, this allows for a smoother control 
over the original source (e.g. smoothing an LFO shape) often giving better results than using direct 
modulation. 
This modifier approach uses four modulation sources called: Filter(X), X*X, Sqrt(X) and Limit(X) 
X=Value, as well as the destination target called X:=Value

For example say we want to use LFO1 with a square wave to modulate the Filter Cutoff, however, 
instead of the direct LFO1 > Filter Cutoff Modulation Matrix option we'll use a modifier to get a 
smoother result:

1. The first thing to do is to set up our LFO settings; go into Icarus' LFO section, the default LFO 
shape is the Tri<>Square, so turn the shape control all the way to the right to change the 
shape from a Triangular to the Square shape.

2. Set LFO1 to use the following settings: BPM: On and Frequency: 2/1CLK.

3. Next, we'll assign a modulation source to our destination X=Value. Go into the Modulation 
Matrix and on the first line assign LFO1+- to the destination X=Value, set the value slider to 
almost full.

4. Now we'll assign one of our modifiers to Filter Cutoff; on the second matrix line go to the 
Source menu>Function(X) and assign Filter(X) to Cutoff 1 and set its slider to again almost 
fully to the right.

You should now hear the LFO modulating the Filter Cutoff parameter using our Filter(X) modifier. 

If you play a little with the Filter(X) matrix line values you can adjust the amount of modifying applied. 
What Filter(X) does in this case is to apply a low pass filter to the value of X. In other words, in the first
line we declared that the LFO1+- function was X and in the second line we told Icarus to use the 
Filter(X) modifier to further modify X's value.
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Even more interesting is that you can also modulate the matrix line containing the modifiers. 
For example, drop in an Aux1 Env > Matrix2 on matrix line 3, set matrix line 2 to a value of 0, and your 
modifier suddenly is being modified by Aux Envelope1. It's a very cool but handy way to apply subtle 
or smoothed modulation. 
Apply for example the X modifier to a volume gate (use the Step LFO for this) and change the amount 
of gating applied over time. This way you can switch between a hard & soft gated volume. 

There are four modifiers available.

• Filter(X) – Filters values, very handy to use with LFO shapes, or for example trance gates to shape 
the type of volume gate used. 

• X*X – Can be used to further shape modify envelopes, for punchier envelopes for example. 

• Sqrt(X) – Also very good to further shape modify LFO / Envelopes with. 

• Limit(X) – Can be used to limit a the amount of modulation by clipping its value within a certain 
range set with the value slider. 

  TIP  You can use Modulation Amount as a destination if you wish to use a Mod source to control the 
amount of modulation of a parameter, e.g. use the Modwheel to control the amount of vibrato 
assigned to another modulator.

Note that the Modulation Amount for Slot1 is 0. This value is modulated by the Modwheel,  which is 
assigned in Slot2. Negative Modulation Amount values are useful if you wish to reduce the  value of a 
parameter with positive modulation. e.g. you can lower the vibrato if when you use the Modwheel.
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■ Arpeggiator

Almost a synth by itself, the arpeggiator section holds the key to all of your arpeggio needs. It offers a 
way to set up your own arpeggios that is both powerful and easy to work with. 
We developed smart algorithms which return melodies that are more useful musically than 
conventional arpeggiators. 
Working with the arpeggiator is extremely simple. Just lay down your notes inside the note-sequencer 
as you normally would and select the play direction. 
Click inside the Arp grid to insert notes, left click-hold a note to move it up or down the grid to edit to 
semi notes.

The arpeggiator also supports optional advanced features such as autochords, polyphonic playback, 
pitch slides, legato, swing-shuffle, split, matrix integration and it gives you very precise control over 
note-sorting, play direction and velocity.

Don’t feel like programming your own patterns? Use one of the built-in patterns or load one of the 
many external pattern presets to use as a starting point.

■ Arpeggiator menu

■ Speed menu – The speed menu is used to set the arpeggiator’s tempo (in CLK)
  

■ Loop menu – The loop menu is used to control the amount of steps the arpeggiator should run, or 
on which step it should stop.

■ Octave / Chord menu –The arpeggiator supports playback over several octaves as well as automatic 
chords. 
To make the arpeggiator play over several octaves click on 'Octaves off' and select 2,3,4 or 5 octaves 
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instead. When you select '3 Octaves' it will play C2 C3 C4 as soon as you press the C key. The 'Chord', 
'5th', and 'Third' modes automatically create chords when you press a single key. You can combine all 
'Octave' and 'Chord' modes with the 'Stack' Arpeggiator mode. In Stack mode a whole stacked major 
or minor chord will be triggered when you hit a single key. It is released when you release the key. 
Make sure that you don't forget to switch to 'Polyphonic' in Icarus' Main Section panel.

■ Play mode menu – Switches the arpeggiator to a specific play mode. The following modes are 
available: 

◦ Default – uses the default play mode.

◦ Bypass High Keys – Switches the arpeggiator to keyboard split mode. Low keys will use the 
arp to playback and higher keys will play normally.

◦ Stack Chord – This mode works together with the Chord option found in the arp menu. It 
uses the selected chord and lets you play that chord using a single key.

◦ Dual Layer – Switches the arpeggiator to Dual Layer mode. In Dual Layer mode OSC1 plays 
the arpeggio while OSC2 plays a chord without the arp. You can set this up using the 
Keysplit High / Low routed to Osc volumes inside of the Modulation Matrix.

◦ Low keys only –  Only the low keys will be used to playback the arp.

◦ High keys only – Only the high keys will be used to playback the arp.

■ Swing / Shuffle menu – The Swing / Shuffle menu allows you to add swing or shuffle to your arp 
pattern. Its default setting is straight – when click-held & dragged up shuffle is increased, when
click-held & dragged down the amount of swing is increased.

          
Straight: When set to its middle position: Straight, all step events are aligned straight to 
the tempo grid.

Swing: When set to a lower position: Swing lets you create various ‘swing’ effects. By 
increasing the amount of swing, step events will have a greater swing groove.

          
Shuffle: When set to a higher position: Shuffle has a specific 8th note rhythmic feel. It is 
based on triplet subdivisions of the beat rather than on dividing each beat perfectly in half 
(a.k.a. straight 8th notes).
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■ Presets 

◦ Load – Loads an arpeggiator pattern from disk.

◦ Save – Saves your arpeggiator pattern to disk.

◦ Reset – Resets the arpeggiator pattern to its default values.

◦ Arpeggiator preset list – Displays a list of available arp presets (found inside of the  
“Icarus_arps” folder.  

Note: Once saved to disk all of your own saved Arp templates will show up inside this menu. Arp 
presets are saved to ’\Icarus_data\Icarus_arps\’

■ Tools Menu

◦ Set direction – Sets the arpeggiator mode. 

◦ Shift / Rotate notes – Shift / Rotate the Arp steps.

◦ Quantize – Quantizes the Arp steps.

◦ Initialize – Initializes random patterns

■ Pattern sequencer

The Pattern sequencer is where all the action happens. Here you will tell the arpeggiator which 
pattern to follow and set up which notes it should use. 
The pattern sequencer is represented by a grid of 32 steps. The horizontal line represents the arp 
sequencer step number, the vertical line is used to set which octave / semi note that step should use.
To switch a step On / Off click on one of the steps. Whenever a step is switched on, it will play back a 
note. When a step is switched off, the last active note will be held until the next active step.
To set which octave a step should use, click within the 4 octave vertical range of the step. To select 
semi notes, click-hold & drag the step up or down.

■ Note sorting / Play direction / Special commands

The 'Arp Order' row is located below the sequencer note grid. This row gives detailed control on how 
the arpeggiator handles the incoming notes. 
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The 'Arp order' command always refers to the current arpeggiator slot.

■ Play direction up
+  (up: CEG CEG) - Sets the play direction of the current slot to 'up'. When you play a chord with three 
notes (C E G) it will start with the lowest note C. After that it will continue with the middle note E. As 
soon as the highest G has been played it will restart with the lowest note C. You can set the play 
direction of all 16 slots to + by selecting 'Load' -> 'Set direction up'.

++  (two up) - Like +, but instead of one it goes two notes up.

+!  (classic up: CEG CEG) - Like +, but without the 'smart melody' algorithm. In this mode the 
arpeggiator behaves as in conventional synthesizers. The (mostly uncomfortable) effect is most 
obvious when you set 'Arp Note semi' in the grid to various values. You can set the play direction of all 
16 slots to +! by selecting 'Load' -> 'Set direction classic up'.

■ Play direction down
-  (down: GEC GEC) - Sets the play direction of the current slot to 'down'. When you play a chord with 
three notes (C E G) it will start with the highest note G. After that it will continue with the 
middle note E. As soon as the lowest note C has been played it will restart with the highest note G.
You can set the play direction of all 16 slots to - by selecting 'Load' -> 'Set direction down'.

- -  (two down) - Like -, but instead of one it goes two notes down.

-!  (classic down: GEC GEC) - Like -, but without the 'smart melody' algorithm. In this mode the 
arpeggiator behaves as in conventional synthesizers. The (mostly uncomfortable) effect is most 
obvious when you set 'Arp Note semi' in the grid to various values. You can set the play direction of all 
16 slots to -! by selecting 'Load' -> 'Set direction classic down'.

■ Play direction alternate
+-  (alt up: CEGE CEGE) - Sets the play direction of the current slot to 'alternate up and down'. When 
you play a chord with three notes (C E G) it will start with the lowest note C and go 'up'. After that it 
will continue with the middle note E. When the highest note G is played it will change the direction to 
'down' and the middle note E will follow. When the lowest note C is reached it changes the direction 
to 'up' again. You can set the play direction of all 16 slots to +- by selecting 'Load' -> 'Set direction alt 
up'.

-+  (alt down: GECE GECE) - Sets the play direction of the current slot to 'alternate down and up'. 
When you play a chord with three notes (C E G) it will start with the highest note G and go 'down'. 
After that it will continue with the middle note E. When the lowest note C is played it will change the 
direction to 'up' and the middle note E will follow. When the highest note G is reached it changes the 
direction to 'down' again. You can set the play direction of all 16 slots to -+ by selecting 'Load' -> 'Set 
direction alt down'.
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■ Repeat last note
REP  (same note again) - Repeats the note played in the previous slot.
■ Random note
?  - Plays a random note

■ Chords
Tt   (chord with 2 notes) - Plays a chord with two notes.

Tt+ (Go up and play a chord with 2 notes) - Like + followed by 2

Tt-  (Go down and play a chord with 2 notes) - Like - followed by 2.

Tr   (chord with 3 notes) - Plays a chord with three notes

Tr+ (Go up and play a chord with 3 notes) - Like + followed by 3

Tr-  (Go down and play a chord with 3 notes) - Like - followed by 3

Pol (Play a chord with all notes) - Plays a chord containing all keys that are currently pressed.

■ Resort notes
SoL  (start with the lowest note) - Forces a resorting of the notes and the lowest note is played. It can 
be musically useful to place this command in slot 0 or slots that you want to attenuate. As a result the 
melody created by the arpeggiator appears less 'chaotic'.

SoH  (start with the highest note) - Forces a resorting of the notes and the highest note is played. It 
can be musically useful to place this command in slot 0 or slots that you want to attenuate. As a result 
the melody created by the arpeggiator appears less 'chaotic'.

■ Release
Rel  (release) - Triggers the envelope's release phase.

■ Legato
Leg  (legato) - When the < is placed in a slot the arpeggiator does not trigger a new note. Instead of 
this it glides from the currently played note to the new one. This command only applies if the current 
and the last note are different. So a combination with 'Arp note' set to one of octave higher / lower is 
useful in most cases.

■ Pitch glide and legato commands
/X  (glide X halftones up) - This glide behaves like you would be moving your pitchwheel up. It raises 
the pitch for X halftones till the next slot. It does not care about the previously or currently played 
note like the legato.
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\X  (glide X halftones down) - Behaves like moving your pitchwheel down. It lowers the pitch for X 
halftones till the next slot. Does not care about the previously or currently note like the legato.

■ Drum-sequencer

Icarus includes a pattern based drum-sequencer from which you can import samples and program a 
percussive layer to use with your Icarus sounds.
Use the drum-sequencer solo in full sync with your DAW or combine your own beats with one of 
Icarus’ many synth features, mixing its oscillators, the arpeggiator and split-modes to build one big 
workstation like patch. The drum-sequencer comes with a host of features to make both programming
and playing sequences as easy as possible.

The drum sequencer comes with 5 drumtracks, each track capable of loading-playing a sample. 
Including 16 steps as well as controls used for further shaping and play options.
Beneath each step you’ll find a velocity bar which can be used for velocity to volume and / or velocity 
to Tune settings. 

A sequencer track with all its settings.

The grid is where you program your percussion, each track includes 16 steps (4 x 4) where you add, 
remove, or alter events in the grid. Once a sample is loaded click on one of the steps to enable / 
disable the sample play for that step. 
The bars displayed below each step represent that step’s velocity value, drag it up / down to edit its 
value, how velocity is handled is changed inside of the tracks’ velocity settings: use the VEL VOL value 
slider to assign velocity to volume, and / or use it to change the sample’s tuning by changing the VEL 
TUNE value. A volume control is provided to edit the sample’s volume, as well as a pan control to 
position the sound in the stereo field (Left-Middle-Right) 
Next to the volume control you’ll find the sample’s envelope controls, namely Decay & Release (Dec), 
Sustain (Sus) and Hold. 

ICARUS 3 Manual - 96 -



Finally the Tune control is used to tune your sample, Mute and FX controls are provided to mute the 
sample or for adding FX.
■ Grid menu
The Grid menu is used for adjusting grid speed and setting the amount of active steps, also included 
are the main volume and grid swing / shuffle settings.

◦ Speed menu – The speed menu is used to set the sequencer’s tempo (in CLK)

◦ Loop menu – The loop menu is used to control the amount of steps the sequencer should 
run, or on which step it should stop.

◦ Volume – Volume is used to set the Drum-sequencer’s main volume.

◦ Swing / Shuffle menu – Allows you to add swing or shuffle to your sequencer pattern. Its 
default setting is straight – when click-held & dragged up shuffle is increased, when click-
held & dragged down the amount of swing is increased.

■ Track controls

■ Sample menu
The sample menu is used for loading & exporting your samples, also included are options to Reset the 
track and Remove (Unload) the sample for that row.

◦ Load WAV –  Loads a Wav file from disc.

◦ Export WAV – Exports the Wav file to disc.

◦ Reset Track – Resets the track to its default settings

◦ Remove Sample – Removes and unloads the sample

  TIP  Drum sequences and their samples are saved inside of your patch so no need to stress over lost or
missing samples, simply save your Icarus patch and you’ll find everything back the way it was the next 
time you load your project or patch.
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■ Sample Playmode

◦ Single –  Plays the sample a single time (default mode)

◦ Loop –  Plays the sample looped

◦ Key – Enables key-tracking for the sample. If several keys are pressed it 
automatically resolves the played chord and plays the base note.

◦ Keyloop – Loops the sample and enables key-tracking. If several keys are 
pressed it automatically resolves the played chord and plays the base note.

◦ Bass – Like Key but limited to a one octave range.

◦ Bassloop – Like Keyloop but limited to a one octave range.

◦ BPM fit – Resynthesizes the sample to fit the BPM, use this with for example when you 
load a drumloop sample.

◦ Mute button – Mutes the track.

◦ Vol – Controls the volume for this sample.

◦ Dec – Controls the Decay-Release time.

◦ Sus – Controls the Sustain level.

◦ Hold –  Controls the hold time.

◦ FX –  Switches FX On / Off for this track. Note that FX send needs to enabled (inside the 
sequencer’s top menu: FX Send) 
Once FX send is enabled FX3 inside of the FX section will be named FX Drum, which also 
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needs to be switched on.
◦ Tune – Tunes the sample.

◦ Pan – Controls the pan (Left-Middle-Right)

◦ Vel Vol – Controls the amount of Velocity to Volume, velocity is set using the velocity bars 
inside of the sequencer.
  TIP  You can use the Velocity to Volume settings to choke samples (choke enables you to 
cutoff a sample more abruptly)
Just set the Vel Vol slider to 100, change the play mode to Monophonic (i.e. only one voice 
per sample will play) and insert your steps inside of the Grid. Now add extra steps after 
each active step and set their velocity value to zero, your sample will now end each time 
the sequences hits a zero velocity value step.
Note that you’re taking advantage of the ‘one voice only Monophonic mode’ here, hence 
why it only works in Monophonic mode and not Release & Overlap modes. 

◦ Vel Tune – Controls the amount of Velocity to Tuning, velocity is set using the velocity bars 
inside of the sequencer.

■ Top menu

■ Split mode

◦ All keys – The Drum-sequencer will play on all keys. 

◦ Low keys only – The Drum-sequencer will only play on the lower
keys. 

◦ High keys only – The Drum-sequencer will only play on the higher keys. 

■ Sequencer play modes

◦ Release notes – Notes played will release as soon as the next 
note event happens.

◦ Overlap notes – All played notes will overlap.

◦ Monophonic – Played notes will end as soon as the next note starts.

■ FX send
Use the FX send control to determine the amount of effects sent in the Drum-sequencer, note that for 
this to work you need to enable one of the track’s FX buttons. Once FX send is enabled you need to 
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enable the FX Drum inside of the FX section.

For example, I want to have a reverb effect on my snare drum (Snare 6; loaded in track 1)

-  First enable the FX button inside of the track you want effects on.

-  Click on the FX send control (default label is FX off) and set it to a value higher than 0, in our 
example it is set to 75.

-  After that go into the FX section, you should now see a section named FX Drum, click on ‘FX Drum 
On’ to switch the section on. Insert a Reverb effect and if all went well you should now hear a reverb 
effect on the snare drum. Note that if you do not see the FX Drum section but instead the default FX3 
section, you need to enable the FX Send inside of the Drum-sequencer.

■ <Preset>
The <Preset> menu offers several preset related load / save / reset options. 

◦ Load Drum Pattern – Drum pattern from disk.

◦ Save Drum Pattern – Saves a Drum pattern to disk.

◦ Reset – Resets the Drum-Sequencer to its default settings. 

◦ Clean Up – Removes all samples that are not in use and cleans up 
the patterns.

◦ Anonymize Samples – Renames the used samples to anonymous 
short names, often handy if sample names are too long for proper 
display.

◦ Presets list. Note: Once saved to disk your own saved patterns will show up inside this 
menu. Drum patterns are saved to ’\Icarus_data\Icarus_drums\Drumpatterns’
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■ Glitch-sequencer

The Glitch-sequencer is a rhythmic based sound modifier that adds multiple glitch suitable effects to 
further mangle and beef up your sounds.
A glitch refers to small imperfections, clicks and other types of errors inside of a sound, also called 
glitches. What a Glitch-sequencer does is use these in an organized rhythmic way to enhance your 
sound. 
The Sequencer consists of a grid with 10 rows, each row representing a different type of effect, with 
16 steps per row.  You can apply either one or several effects at once to each step, with a large amount
of effects being available, namely: a Repeater, Gate, Pan, Tremelo, Lowpass & Highpass filter, 
Bitcrusher, Degrader, Detune and Pitchslide effect. Its possibilities are almost limitless, from subtle 
glitch effects to completely destroying your sound.

Click on a step inside of the grid next to the effect you want to apply to that step, in the example 
above we’ve added the Gate effect to all 16 steps and edited step 2 to apply a gate effect.
Hold Control+left-click to automatically set the step to half of its full value.

In our next example we’ve also added the Repeat effect with different repeater settings on all 16 
steps.

By adding more effects and fine tuning how much of the effects are applied you can build all kinds of 
rhythmic glitch sequences. Effects are turned On / Off by clicking their respective boxes. The R buttons
next to each effect randomize effect values for each of its 16 steps.
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■ Glitch Effects

◦ Repeater – Uses part of the input signal and repeats it several times. The 
amount of times the signal is repeated is determined by the value set inside 
the step.

◦ Gate – Applies a gate effect, its step value determines how low the signal is 
muted.

◦ Pan – Positions the sound in the stereo field (Left-Right)

◦ Tremelo – Applies a tremelo effect.

◦ Lowpass – Low pass filter, the cutoff frequency determined by the value set for that step.

◦ Highpass – High pass filter, the cutoff frequency determined by the value set for that step.

◦ Bitcrusher – Reduces the bit resolution with the amount set for that step.

◦ Degrader – Reduces the sample rate based on the amount set for that step.

◦ Detune – Detunes the step.

◦ Pitchslide – Applies a pitchslide to the step.
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■ Glitch Sequence options

• Speed – Sets the speed used to play the glitch sequence.

• Steps – Defines the amount of active steps inside of the sequencer.

• Straight –  The Straight / Swing / Shuffle menu allows you to add swing or shuffle to your 
sequence pattern. Its default setting is straight, when click-held & dragged up shuffle is 
increased, when click-held & dragged down the amount of swing is increased.

• Mix – Controls the balance between the input and processed mix, values lower than 100 will 
mix the original non processed signal back in.

• Smooth – Controls the smoothness, used to avoid clicks or get a rougher sound.

■ Route – Controls at which point inside the signal path the Glitch-sequencer is inserted. 

◦ Post FX – Inserts the sequencer at the end of the signal chain; Synth, FX & Drums are 
processed.

◦ Synth only – Inserts the sequencer after the Synth; Synth & FX are processed.

◦ Drums only – Inserts the sequencer after the Drum-sequencer; Only drums are processed.
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■ <Preset> – The <Preset> menu offers several preset related load / save / reset options. 

◦ Load – Loads a Glitch-sequencer pattern from disk.

◦ Save – Saves a Glitch-sequencer pattern to disk.

◦ Reset – Resets the Glitch-sequencer to its default settings. 

◦ Presets list.

Note: Once saved to disk your own Glitch patterns will show up inside this menu. Patterns are saved to
’\Icarus_data\Icarus_glitch\’

■ <Tools> – The Tools menu offers several edit tools for the sequencer.

◦ Rotate left – Shifts the sequence one step to the left.

◦ Rotate right – Shifts the sequence one step to the right.

◦ Clean unused slots – Cleans all unused slots, i.e. rows that are not active will be reset to 
their default values.
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■ FX

The FX section consists of three effect slots, a feedback feature as well as a limiter section.
No less than 60 effects are available from the FX section, ranging from Reverb, Delay, Chorus, and 
Phaser, to Tremelo, Vibrato, Distortion, Amp-Simulation, Multiband Distortion, Bitcrush, Degrader and 
Compressor.

Click on the FX Tab to go to the effect options screen. 

Click on the FX1 button to switch on the effect slot and on the bypass label to open a listing of 
available effects to select one.

Once you selected an effect, the available parameters will update accordingly inside its FX display 
window. The parameters can be changed by click-and-holding your left mouse button and dragging 
the bar.

■ Feedback
The Feedback feature allows you to control the amount of signal fed back into the FX's input.

■ Limiter
The limiter section applies gain reduction to attenuate (reduce) transients and dynamics, it can be 
used to stop the signal from clipping or distorting.

• Threshold – Sets the point (Threshold) at which the automatic volume reduction is applied.

• Ratio –  Determines how much the volume is reduced versus how far above the threshold the 
signal is. 

• Attack – Adjusts how quick the volume is reduced once the input exceeds the threshold.

• Release – Adjusts how long it should take before the volume returns (released) to its original 
value when the input is no longer above the threshold.
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■ FX Routing
Inside the Routing menu you'll find several options having to do with how the effects are routed or 
applied to the signal, click on the Routing FX… label to see it offer the following options:

◦ Routing FX1 FX2 Serial – The dry output of the synthesizer is sent to FX1. Mix1 controls the
dry / wet mix of FX1. The mixed signal is sent to FX2. Mix2 controls the dry/wet mix of FX2.

◦ Routing FX1 FX2 Parallel – The dry output of the synthesizer is sent to FX1. Mix1 controls 
the dry/wet mix of FX1. The dry output of the synthesizer is also sent to FX2. Mix2 controls 
the dry/wet mix of FX2. 

◦ Routing Left:FX1 Right:FX2 – In this mode the synth's left dry signal is send into FX1, the 
synth's right dry signal is sent into FX2. 
  TIP  This mode can be used to assign two different effects to two different oscillators. First 
select two different effects for FX1 and FX2, for example a reverb and chorus. Then set the 
PAN knob of OSC1 to -100 to pan it left and set the PAN knob of OSC2 to +100 to pan it 
right. Now OSC1 will be processed with a reverb and OSC2 will be processed with a chorus.

■ <Preset>
The <Presets> menu offers several effect related load / save / reset options.

◦ Reset FX – Resets all effect slots to their default settings.

◦ Load FX Template – Loads an effect template from disk.

◦ Save FX Template – Saves an effect template to disk.

Note: Once saved to disk your own FX templates will show up inside this menu. Templates are saved to
’\Icarus_data\Icarus_effects\’
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■ FX controls
The FX mix slider controls the wet / dry balance of the effect section, note that this slider is linked to 
the FX MIX knob inside the main section.

The FX1, FX2, FX3 Duck sliders provide a Ducking mode control
that help make the mix sound more transparent. 
Especially with long Reverbs and Delays you frequently face the
problem that a part of the delay tail overlaps with a currently
played note. As a result it either 'messes up the mix' with 'too
much effect mix' or the delay effect is nearly inaudible, because
the mix level had to be reduced a lot.
To solve this problem we introduced a ducking feature which allows a higher effect mix without 
making the synth sound 'over effected'.

■ Effect types

■ Reverb

◦ Reverb Medium – Simulates a medium room with lots of diffusion.

◦ Reverb Big – Simulates a huge room with lots of diffusion.

◦ Reverb Plate – Simulates a plate reverb, which uses an electro-mechanical transducer to 
create vibration in a large plate of sheet metal. 

◦ Reverb Glass – Simulates a bright room which absorbs low frequencies.

◦ Reverb Dark – A darker type of reverb.

◦ Reverb Infinite – A reverb with an infinitely long reverb tail (great for Pads, FX and Ambient
tracks)

◦ Reverb Feedback – A reverb with feedback with a metallic type of sound.

◦ Reverb Spring – Simulates a hardware spring reverb system, which uses a transducer at 
one end of a spring and a pickup at the other, similar to those used in plate reverbs

◦ Reverb Trance – A reverb specifically tailored for Trance based music styles.

◦ Reverb Cheap – A cheap type reverb sound like those found in cheaper or older hardware 
FX units.

◦ Reverb Gated – A gated reverb that syncs to the BPM rate, works best for drums or 
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arpeggiator sounds.
◦ Reverb Gated Echo – A gated reverb with a delay that syncs to the BPM rate.

◦ Reverb Decay – A decaying reverb that syncs to the BPM rate.

◦ Reverb Reverse – A reversed reverb effect.

◦ Reflections – When size is set to 0 it can be used to simulate early reflections, larger values 
sound like a chaotic echo.

■ Delay

◦ Delay Wide – A broad sounding delay with Hi and Low Damp filters

◦ Delay Fat – A fat sounding delay with detuning. In this mode the mix knob controls the 
amount of feedback.

◦ Delay Diffuse – A fat sounding delay with diffusion and detuning. It has a silky sound.

◦ Delay Band – Filtered stereo delay synced to your host's tempo. The frequency bandwidth 
gets more and more narrow over time. Useful for classic psychedelic sounds from the 60's.

◦ Delay Classic – A classic Stereo delay synced to your host's tempo.

◦ Delay Dual – A double delay. Delay times for the left and right channel can be changed 
individually.

◦ Tape Delay – A delay effect based on the classic Tape Delay hardware units, which used 
magnetic tape as their recording and playback medium.

◦ Multitap – Very powerful multistage delay with rhythmic beats. Also includes a number of 
pingpong types and a reverse delay mode.

◦ Pingpong – A tempo synced delay which alternatively pans from left to right.

◦ Echo / Slapback – A slapback delay effect, which uses a mixing of the original and delayed 
sounds to creates an effect similar to doubletracking.

◦ Resonater – A resonator delay effect.
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■ Chorus

◦ Chorus – A warm stereo chorus with a rich sound.

◦ Smart Unison – Creates the sound of several detuned stereo voices, with very low CPU 
demands

◦ Ensemble – Simulates a large number of detuned voices playing at the same time. Adds 
richness and movement to sounds. Very useful for vocal pad sounds.

◦ Vibrato – Detunes the sound with an LFO.

◦ Vibrato stereo – Detunes the sound with an LFO, can be used instead of chorus if a tight 
timing is needed.

◦ Rotary – Simulates a rotary speaker / Doppler effect made famous by the Hammond organ.

■ Phaser

◦ Phaser – Creates a series of peaks and troughs in the frequency spectrum. The position of 
the peaks and troughs is modulated so that they vary over time creating a sweeping effect.

◦ Phaser Stereo – A stereo phaser with a vocalic sound.

■ Flanger

◦ Flanger – Peaks and notches are produced in the resultant frequency spectrum related to 
each other in a linear harmonic series. Creates a sweeping effect.

◦ Flanger Stereo – Peaks and notches are produced in the resultant frequency spectrum 
related to each other in a linear harmonic series. Creates a sweeping effect.

■ Panning

◦ Autopan – An automatic panning effect.

◦ Surround Pan – A surround panning effect.

■ Equalizer

ICARUS 3 Manual - 109 -



◦ EQ High Cut – A High-band (High Pass) equalizer effect.

◦ EQ Low Cut – A Low-band (Low Pass) equalizer effect.
◦ EQ Param – A parametric 3-band equalizer.

◦ Laser Punch – Adds additional punch to the sound. Use it with a sawtooth to create a 
zapping 'Rubber Bass' type of sound.

■ Distortion

◦ Saturate – A saturation effect.

◦ Soft Clip – Provides a soft clipping effect.

◦ Hard Clip – Provides a hard clipping effect.

◦ Rectify – Hard-clips the signal and mixes the processed signal back in with the original 
sound.

◦ Bitcrush -  A lo-fi (low fidelity) digital audio effect.

◦ Warp – A warp distortion effect.

◦ Waveshape – Waveshaper effect.

◦ Ripple – A Ripple distortion effect.

◦ Amp Sim – Simulates a guitar amplifier.

◦ Multiband Distortion – A multiband distortion effect.

■ LoFi

◦ Degrader – Sample rate reduction effect.

◦ Multiband Degrader – A sample rate reduction effect that operates on multiple separate 
bands.

◦ Noise – A noise effect with the options to add White, Pink noise, Crackle or Hum to your 
signal.
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■ Stereo Imaging

◦ Stereo Width – Spreads the panorama from mono to surround

◦ Surround Encode – Dolby Prologic II compatible surround encoder. It is also useful to add a 
more spatial effect to your stereo recordings. If you encode to ‘Back’ the channel will come 
from the rear speaker if you play your song on a surround system. The sound remains fully 
stereo compatible.

■ Dynamics

◦ Tremolo – Modulates the amplitude with an LFO.

◦ Compressor – Boosts the volume of lower volume notes, while capping the louder ones, 
giving a more even level of volume.

◦ Gate – Applies a rhythmic volume gated pattern to the sound.
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■ EQ

The EQ section gives a broad tone control over the synth’s output, its three controls give a boost or cut
over the low, middle and high frequencies. Changes to frequency curves can also be freely edited 
using the mouse, simply left-click within the frequency display and drag up or down to change its 
settings. Click on the On button to switch the EQ section to on or off.

■ EQ controls

• Low – Adjusts the lower frequencies. Set to the middle position it's function is by-passed.

• Mid – Adjusts the middle frequencies. Set to the middle position it's function is by-passed.

• High – Adjusts the higher frequencies. Set to the middle position it's function is by-passed.

• Dbass – Equalizes non-linearities of the human ear, making the patch sound thicker and louder,
without raising the overall volume. 

• Freq. – Shifts the EQ Mid Frequency.

• Q – Adjusts the EQ's bandwidth: number of frequencies that will be cut or boosted.

Use the EQ presets menu to select from a range of equalizer pre settings.
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■ Setup

The setup section in Icarus covers the general settings like Trigger modes, Oscillator punch settings, 
Skin preferences, MPE support and the Master Tuning control.

■ Trigger-mode
The trigger mode menu allows you to control which Arpeggiator / LFO synchronization settings will be 
used by Icarus.

◦ Arp/Lfo hard trig – Uses Hard Trigger mode for the arpeggiator & LFOs.

◦ Arp/Lfo Free – Uses Free Running mode for the arpeggiator & LFOs.

◦ Arp/Lfo Soft hard – Uses Soft Hard mode for the arpeggiator & LFOs.

◦ Arp/Lfo Soft trig – Retriggers monophonic LFOs after 1 second of silence.

◦ Arp/Lfo Classic trig – Allows to set free mode for every LFO individually.

■ Oscillator punch-mode
The oscillator punch-mode section gives you the option to add an
additional punch / click to the attack portion of the sound. The
option can be switched on separately for each oscillator and fine
tuned with the Punch Click menu (Punch Click 12% > Punch Pump
800%)

ICARUS 3 Manual - 113 -



■ Master-tuning
The Master tuning controls the master tuning used in Icarus.

■ MPE Support
This option switches on MPE support for Icarus. MPE, stands for MIDI Polyphonic Expression. 
MPE uses MIDI that allows multidimensional controllers (MDCs), such as the ROLI 
Seaboard and the LinnStrument, to control multiple parameters (such as pitch bend, 
vibrato, timbre, volume) of every single note separately.

Note! only enable this if you connected an MPE device.

■ Set skin color>
The skin color menu allows you to set or change the color scheme used by Icarus, simply click open 
the menu and select your preferred scheme, Icarus will instantly adjust to the new colors.
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